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intelligent Workload Distribution 8.5 Deployment Guide

intelligent Workload Distribution 8.5
Deployment Guide

Welcome to the intelligent Workload Distribution 8.5 Deployment Guide. This document describes
how to install and configure intelligent Workload Distribution (iWD).This document is valid for 8.5.0

releases of this product.

This document is primarily intended for IT staff who are responsible for iWD installation and
configuration and business analysts who are responsible for department and process configuration. It
has been written with the assumption that you have a basic understanding of:

¢ The workflow concepts as implemented in the various enterprise source systems (for example, business
process management (BPM) systems, host systems, CRM systems, and so on) from which iWD solution

will capture tasks.
* Network design and operation.

¢ Your own network configurations.

Overview Installation Overview

New in Release 8.5.0 Deployment Overview

Systems, Platforms and Compatibilities Installation Phase Overview

iWD Solution Architecture for 8.5.0 System Configuration Overview

Migration to 8.5.0 Business Logic Overview

Installation 1 Installation 2

Prepare for Installation - UPDATED Creating the (Tenant and) Solution in GAX
Plug-in

Interaction Server Configuration
Working with Integrated Capture Points

Installing/Removing iWD GAX Plug-ins-
UPDATED iWD Setup Utility
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New Features by Release

Changes in this Document

* Genesys recommends configuring a separate Message Server for the iWD GAX Plug-in to prevent log
files becoming excessively large. See Adding/Removing a Dedicated Message Server for iWD
GAX Plug-in.

* New Troubleshooting topics.

New in 8.5.0

Re-architecting of IWD

Most of the deployment and configuration of iWD is now carried out using new components and
interfaces. Some of the effects of this change are:

e Standardization of many of the procedures involved with deployment and configuration, using new
components as well as a refreshed iWD Manager component.

¢ A completely new user configuration interface based on the Genesys Administrator Extension (GAX)
plug-in.

¢ Removal of support for configuration using the Genesys Configuration Manager client.

The changes are detailed as follows:
¢ iWD is now deployed by means of a new GAX Automatic Service Deployment (ASD) plug-in component
called iWD Setup Utility.

e iWD configuration is now performed via Genesys Administrator Extension (GAX) and a new iWD GAX
plug-in component. Specifically, the following aspects that were previously carried out in iWD Manager
have now moved:

* Tenant profile (to GAX)

* Lookup tables (to iWD GAX Plugin)

e Services (to iWD GAX Plugin)

* Generic capture point (to GAX)

» Data Mart Services (to iWD GAX Plugin)

* Departments and processes (to iWD GAX Plugin)

* Audit history (to a centralized log database)

iWD Deployment Guide 5
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e Security policy (to Genesys Administrator, using Role-Based Access Control (RBAC))

e The IWD Data Mart Services view is now replaced by a GAX dashboard monitoring the state of the Data
Mart node.

¢ Data Mart can now run as a standalone Java module and is now managed directly using Solution Control
Server.

* The modules and components mechanism is removed from iWD Manager.
e The Business Context Management Service (BCMS) functionality is moved to the Genesys Rules Engine.
e |[WD Manager is now used primarily for task management and monitoring using the Global Task List.

e Support for legacy capture points is removed.

Deployment/Configuration Using Genesys Administrator Extension
e Support for configuration using the Genesys Configuration Manager client is withdrawn in release 8.5.0.

* You must use Genesys Administrator Extension (GAX) together with the iwD GAX Plugin component for
deployment and configuration in release 8.5.0.

High Availability
e Support for Unresponsive Process Detection in iWD Runtime Node

Additional Database Server Support

e Support for SQL Server Cluster 2008
e Support for MS SQL Server 2012
e Support for MS SQL Server 2012 Cluster

Additional Platform Support

e Support for Windows Server 2012 64-bit native
e Support for Red Hat Enterprise Linux 6.0 64-bit native

Additional Virtualization Platform Support

e Support for Windows 2012 Server Hyper-V

Additional Servlet Support

e Support for Java 7 SE bundle

iWD Deployment Guide 6
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New Features by Release

e Support for Java 7 EE bundle

Additional Servlet Engines

e Support for Websphere 8.5

Additional Browser Support

¢ Support for Google Chrome
e Support for Internet Explorer 10 and 11
e Support for Firefox 24ESR

Discontinued Support

e Internet Explorer 7

e Firefox 3, 4

e MySQL - all versions

e Oracle 10g and 10g RAC

* IBM AIX 5.3

e MS Windows Server 2003

* Red Hat Enterprise Linux 4

* Solaris/SPARC version 9

¢ WebSphere Application Server 6

iWD Deployment Guide
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Guide Summary

Systems, Platforms and Compatibilities
summary

Please refer to these documents for further information.

Release 8.5

Genesys Supported Operating Environment Reference for iWD Provides operating environments
information required to run Genesys iWD.

Genesys Interoperability Guide

Use this document for product availability and interoperability when you plan to
add or upgrade Genesys products.
Genesys Supported Media Interfaces Reference Manual

Use this document for information on media interfaces.
Genesys 8.1 Security Deployment Guide

Use this document for information on how to configure security levels for your environment.

iWD Deployment Guide 8
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WD Solution Architecture for 8.5.0

Video - Differences between 8.1.1 and 8.5.0

Click here to watch a short video of differences between the 8.1.1 and 8.5.0 architectures.

8.5.0 Architecture Diagram
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Migration to 8.5.0

Before Migration-Genesys Rules System

1. From GRAT, export templates as an XML file.

2. From GRAT, export each rule package as an XML file.

3. Create a new database for GRS 8.5.

4. Install GRS 8.5 and point it to the newly created database.

IWD Migration from 8.1.1

1. From iWD Manager 8.1.1, export the configuration to .xml files. All tenants must be exported.
2. Install Genesys Administrator Extension 8.5.000.47.

3. Upgrade the Genesys Rules System to 8.5.001.

4. Install iwD 8.5 components including iWD Plugin for GAX.

iWD Manager has a new template in 8.5— this must be upgraded as well.

After iWD Manager is installed, configure roles and privileges for IWD.
Upgrade the Business Process.

Upgrade the Standard Rule Templates.

Start GAX. Make sure, that iWD Plugin for GAX is available.

A S

If setting up a new system, make sure that:

All tenants are already created (the migration script does not create Tenants).
e The Interaction Server application and Database Access Points (DAPs) are defined.

¢ The Runtime Node application and Runtime Node DAP application are defined.

e Install Python 2.6 or 2.7 and the httplib2 library. GAX must be accessible through network from the machine
where Python is installed.

¢ Run the script for each tenant being migrated, including the System tenant. For the System tenant, provide
same .xml file for flags -s and -i.

iWD Deployment Guide 10
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python main.py -t <tenant name> -r <tenant runtime id> -i <tenant export file>.xml -s
<system tenant export file>.xml
—g <GAX URL> -u <username> -p <password> -v —d <mapping file>.ini

Review the configuration using iWD Plugin for GAX.

Create new integrated capture points based on iWD 8.1 legacy capture points. See the Working with
Integrated Capture Points section.

Start iWD Manager and upgrade the iWD Manager database.

If you are migrating an existing system/Data Mart configuration, update the Audit Events. Do this by running
the following query against the Data Mart database, after the Business Structure is configured in
Configuration Server:

DELETE FROM ETL AUDIT WHERE PROCESS NAME = 'Load Config GTL DM'

Start iWD Data Mart Node (optional).

The mapping.ini File
The mapping_file.ini is a standard ini file. It contains three sections:

* DAP—Defines the mapping of the solution to the Database Access Point application.

* Inx—Defines the mapping of the solution to the Interaction Server application.

» |DBC—Defines the mapping of the Interaction Server application to the JDBC URL string.
Example

# 'DAP' section adds mapping to Database Access Point

# used by solution:

# <solution name> = <Database Access Point application name>
[DAP]

selenium_solution = iWD Node selenium2 DAP

selenium solution2 = iWD Node selenium22 DAP

# 'Inx' section adds mapping to Interaction Server

# used by solution:

# <solution name> = <Interaction Server application name>
[Inx]

selenium solution = InteractionServer 812

# 'IDBC' section adds mapping to Event Log:

# <Interaction Server application name> = <JDBC url string>
[JDBC]

InteractionServer 812 = jdbc:evo:oracle:@//localhost:1521/xe

This mapping is required to properly tie associate Configuration Server’s components. Note that in case of applications (DAP, INX), the
migration script requires that they must be defined and configured in Configuration Server.

After Migration- Genesys Rules System

In GRAT 8.5, using newly created DB repository:
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Import templates from the XML file.

From each solution, import appropriate rule packages from the XML file.
Deploy each rule package to GRE 8.5.

Export templates from GRAT as XML file.

Export any rule packages as XML files.

Delete and recreate the business structure

No v ok w N e

Import templates from the XML files.

Migration From Releases Prior to 8.1.1

No direct migration process is supported from releases earlier than 8.1.1 to 8.5.0. To migrate from these earlier releases, you must first
migrate to 8.1.1.

iWD Deployment Guide 12
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Deployment Overview

Genesys strongly recommends that you perform all 8.5.0+ configuration using the
Genesys Administrator Extension (GAX) and the iWD Plug-in for GAX

Deployment of IWD consists of three main phases:

¢ Installation phase
e System configuration phase

¢ Business logic configuration phase

iWD Deployment Guide 13
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Installation Phase Overview

Definitions

Installation is the initial iWD deployment phase that results in a fully functional iwWD Manager
application and prepared iWD runtime node. Whereas in pre-8.5.0 releases, iWD Manager was used
for the rest of the deployment configuration, from 8.5.0 most of the configuration is carried out using
the Genesys Administrator Extension (GAX) component and the iWD Plug-in for GAX component (from
now on referred to as iWD GAX Plugin).

In 8.5.0, iWD Manager is used mostly for task monitoring and management via the Global Task List.
The iWD Runtime Node is a container in which the iWD runtime services run.

The installation phase requires knowledge of the overall system infrastructure in which iWD is being
deployed, such as Java web application server and database configuration. This phase is typically
implemented by IT personnel.

iWD installation consists of two steps:

e Preparing databases

* Installing applications

Database Preparation

The first step of iWD installation is database preparation. A basic iWD deployment uses four
operational databases:

¢ iWD Configuration database—iWD Manager utilizes a database in which all of the configuration data
(GTL Filters) is stored. The rest of the configuration have moved to the Configuration Server database.

e Genesys Rules System rule repository—Stores business rule templates and business rules. For more
information, see the Genesys Rules System 8.5 Deployment Guide

e Interaction Server databases—Stores iWD tasks and related task events. Make sure that you have
installed and configured the Interaction Server and its associated databases, as described in the
eServices (Multimedia) 8.1 Deployment Guide.

e Data Mart database—Uses Fact tables, aggregates, dimension and measures to provide sophisticated
reporting options.

For a list of the database engines that are supported by the iWD application, Genesys Rules System,
and Interaction Server, refer to the Genesys Supported Operating Environment

Reference _Guide. Please note that the iWD application might not support all of the databases that
are supported by Interaction Server or the Genesys Rules System.

iWD Deployment Guide 14
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To prepare the iWD Configuration database, two actions must be performed manually via the
database's administrative interface:
e Creation of a database
¢ Creation of a database user who will need the following permissions:
* CREATE TABLE
* CREATE INDEX
* CREATE VIEW
* CREATE TRIGGER (Oracle)
e CREATE SEQUENCE (Oracle)

The rest of the database setup, such as creation of tables and indexes, is performed automatically by
iWD.

Application Installation

After the iWD operational databases have been prepared, the iWD GAX Plugin component, the iWD
Manager application and the iWD Runtime Nodes can be installed. iWD Manager runs on a Java
application server. iWD Runtime Node is a stand-alone Java application. In release 8.5, both should be
installed manually and subsequently configured by using Genesys Administrator Extension (GAX).

Refer to the Genesys Supported Operating Environment Reference Manual for a list of the
Java application servers that are supported by iWD.

A basic iWD deployment, such as in a lab environment, utilizes a single instance of iWD Manager, as
well as a single instance of an iWD Runtime Node. In more complex scenarios, such as multi-tenant,
high-volume or high-availability deployments, multiple iwD Runtime Node instances can be installed.
These deployments provide more controlled resource partitioning and allow load distribution across
multiple physical servers.

Up to release 8.1, for a production deployment, Genesys recommended that you deploy iWD Data
Mart services on a dedicated iWD Runtime Node. In release 8.5, Data Mart can be run as a stand-
alone Java application and can be controlled by Solution Control Service (SCS)

In addition to the iWD GAX Plugin, the iWD Manager and iWD Runtime Node installation, Genesys
Rules System must be installed. This installation includes:
¢ Genesys Rules Development Tool, which is an Eclipse plug-in for business rule template development
* Genesys Rules Authoring Tool, which is used for authoring and deploying business rules

¢ Genesys Rules Engine, which is an engine that receives and processes requests for business rule
evaluation from clients, such as the routing strategies in the iWD Business Process (IWDBP).

iWD Deployment Guide 15
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System Configuration Phase Overview

Tenants

iWD configuration supports multi-tenancy. iWD automatically creates a root tenant that is named
System by default. The System tenant is automatically mapped to the Environment tenant in
Genesys Configuration Server. Although it is possible to configure iWD solutions, services, and
business logic directly at the System tenant level, it is recommended that you create a subtenant for
that configuration. In iWD terminology, such a subtenant is called a managed tenant. This managed
tenant is associated directly with a tenant defined in Genesys Configuration Server. In a single-tenant
environment the configured managed tenant maps to the Resources tenant in Genesys Configuration
Server.

A user who is configuring the system in Genesys Administrator Extension (GAX) can have access to
one or more managed tenants. Access is defined by the role-based access controls that are
configured in GAX, per tenant. The policy allows definition of an arbitrary numbers of user roles,
where each role can be assigned to any Genesys Configuration Server users or access groups. Each
role has a number of associated iWD permissions. Note, that iWD Manager and iWD GAX Plugin have
separate lists of permissions.

The tenancy model that is supported in the iWD application currently has a one-to-one
relationship with the tenancy model in Genesys Configuration Server.

Multi-tenant Configurations

If you are using a Multi-Tenant Configuration Server, please be aware that the iWD tenant can only
access resources (such as Skills and Agent Groups) that are specifically configured under the
corresponding Genesys Configuration Server Tenant in GAX. Therefore, any Skills, Agent Groups, or
other resources that are configured at the Environment Level will not be accessible in rules at a child-
tenant level in iWD. To make these resources accessible, they must be configured as resources under
the child tenant in Configuration Server.

Solutions

Solutions are used for partitioning logical and physical resources for purposes of user access control
and load partitioning (performance). Normally there will be one Solution per Tenant.

A solution in iIWD represents a runtime environment, which is composed of the following:

¢ Runtime nodes—iWD runtime application instances that are stand-alone Java applications. Runtime

iWD Deployment Guide 16
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nodes require simple preparation during installation.
» StatServer—Provides statistics to CCPulse+ via iWD Stat Extensions
* Business logic configuration—Primarily the configuration of iWD departments and processes.

e Multiple solution instances can be configured per tenant, if necessary (for example, “Production” and
“Test”).

Runtime Nodes

Runtime Nodes are instances of the iWD runtime application and are run as a stand-alone Java
application. Services that run within a runtime node are configured in (and managed through) the
iWD GAX Plugin application.

Services

iWD Services implement actual iWD functionality, such as loading data into the Data Mart. Refer to
iWD Services for more information about iWD Services, including the recommended order of
configuration.

iWD Deployment Guide 17
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Business Logic Configuration Phase
Overview

The iWD business logic configuration phase is where iWD business context is introduced. This
includes definition of departments and processes. This phase also includes the definition of business
rules for use in task processing. After this phase, iWD is fully functional and can start processing
tasks. The iWD system configuration phase requires knowledge of business context for tasks that will
be handled by iWD. This includes business processes, service-level agreements (SLAs), and other
factors that influence task-handling logic.

Departments and Processes

Departments represent organizational entities for which iWD will perform task prioritization and
routing. Processes represent the business processes that are within those enterprise departments. In
iWD, processes are always grouped within (associated with) a department. Departments and
Processes allow for the definition of task-handling business rules that are specific to a department or
process context.

Departments and Processes are created in iWD GAX Plugin and stored on Genesys Configuration
Server. They are used by iWD Manager for task filtering and Genesys Rules System for managing
rules.

Each department and process allows for the definition of a maximum of 5 custom attributes to a
department/process in order to provide additional enterprise-specific context for reporting purposes.

Rules

Part of configuring the business logic for departments and processes in iWD is configuring and
associating rules. All business rule authoring for iWD is done through the Genesys Rules Authoring
Tool, which is a component of the Genesys Rules System. These rules define the task-handling
business logic that is applicable to the departments, processes, or the entire system. Generally, a
rule is represented by zero, one or more conditions and one or more actions. If there are no
conditions for the rule, its actions will always be executed. If all of the conditions are true, all of the
actions are executed. If any condition is not true, none of the actions are executed.

Rules are expressed in an easy-to-understand human language, such as:
If the task is due in 10 or more minutes, increase priority by 10.

The implementation details are hidden in rule templates, and users who configure business logic deal
only with high-level logical expressions.

Rules can be defined in one of two ways:
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¢ As a linear rule

¢ As a decision table.

Linear rules are intended for complex rules that have many conditions and/or actions. Each condition
or action is represented by a single line in the rule. Linear Rule Example shows an example of a linear
rule.

Decision tables represent a more compact form of rule representation; however, they might not be as
well suited to complex rules. In a decision table, multiple rules are grouped together, so that each
condition or action is represented by a column in a table, and each row represents a rule. The
number and type of conditions and actions (columns) is constant across all of the rules in the list.

Task Classification

Task classification does the following:

e Associates a task with a configured process.

¢ (Optionally) assign values to other task attributes, such as business value and due time.

Task-classification logic is expressed via business rules that can be defined for three different
contexts:

¢ Package-level rules (also known as Global Rules)

e Department

* Process

If rules are defined for more than one context, they are evaluated in sequence, as previously listed.
After a process has been assigned to a task, additional classification rules are evaluated that have
been defined, first at the rule package or global level, then at the department level, and finally at the
process level. The figure below shows an example of Task Classification.

A process must be assigned during the classification phase. It can be assigned in two places:

e At the global level

e At the department level.

(A department can be assigned at the global level and then, the rule evaluation can continue at the
department level to actually select a process.)

Capture Point rules are configured at the rule package (global) level, by using the rule
condition Capture Point is.

iWD Deployment Guide 19
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Task Classification Using the “Capture Point is” Rule Condition

For more information about task classification, refer to Working with the iWD Business Process.

Task Prioritization

The primary purpose of task prioritization is dynamic priority calculation, where dynamic means that
the task priority can be recalculated multiple times during the task’s life cycle. As with task
classification, prioritization logic is expressed via rules.

Prioritization rules are initially applied immediately after classification rules and then reapplied after a
specified reprioritization period. The reprioritization period is expressed in the same way as any other
rule action.

Task Prioritization

If a reprioritization period is not set for a task during the prioritization phase in business rules, the
IWD reprioritizeDateTime attribute is set to Dec 31, 2030. Therefore, for all intents and purposes.
the task will not undergo further reprioritization unless it is restarted.

The Standard Rules Template includes two rule conditions, Is first prioritization and Is
reprioritization that should be used in prioritization rules to ensure that the reprioritization
interval is set correctly, while avoiding any unnecessary immediate reprioritization of a task (that is,
the first time prioritization rules are evaluated).

For example, suppose you have a task that, during the classification phase, gets an initial priority of
100. You wish to increase the priority by 15 every 2 hours, if the task is due in less than 24 hours. You
want to do the first check 1 hour after the task is classified. You would set this up by using two
different prioritization rules, configured in the order shown below. The example Rule 1-Is First
Prioritization shows the first rule, which includes the Is first prioritization condition. The
second rule, shown in Rule 2-Is Reprioritization, includes the Is reprioritization condition.

Rule 1—Is First Prioritization

Wieh Pequests '|wcn'lii'li-'||1'|wndinn|v
[ 1] Hame Vebform Bl | Ovder Todal Tazk Due -..lﬁ Requesst agent ul‘llulla
o & ancaeds &
OTR-256  Grod I 1 4715 3000 72 hioudrs E-mBdl CLd, rEn i qroup
OTR-25F  Groug2  oTi3 5000 4 hours Supardsars
OTR-255 Grouf s oTi6 2000 72 hours 131 ]
OTR-288  Grougd  dTi6 700 &6 hours Suparvsars

Rulel-Is First Prioritization Example
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Rule 2—Is Reprioritization
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Rule2-Is Prioritization Example

For more information about task prioritization, refer to the Working with IWD Business Process
documentation.

Business Calendars

A business calendar is a set of configuration parameters that define working days and hours, as well
as holidays that apply to the business. In its simplest form, the business calendar would consist of
definitions for both a working week and working hours that apply to all working days.

A definition of a working week from Monday to Friday—in which each day starts at 9:00 AM and ends
at 5:00 PM—is a classic example of a simple business calendar. If necessary, exceptions to the usual

working schedule (public holidays, business-specific holidays, nonstandard working hours, and so on)
can be added to the business calendar.

Business calendars can be used in iWD rules to perform date and time calculations that take into
account the working schedule of the business. Business calendars can either be assigned to a rule

itself, or can be assigned in a rule action. In either case, the business calendar must be assigned
before other rules that use the business calendar can be evaluated.

Business Calendars are created in the Genesys Rules Authoring Tool.

Business Calendar
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Business Calendar Example
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Installation

Task Summary: Installing IWD 8.5

The following table outlines the task flow for installing iWD 8.5. The procedures referenced in this
table provide instructions about installing iWD components on Windows hosts.

Installing iWD 8.5

Objective

Prepare for installation and review prerequisites.

Install Interaction Server.

Install Genesys Administrator Extension (GAX) release
8.5.000.47 or later.

Install the iWD GAX Plugin.

Install the Genesys Rules System. GRS 8.5.001 or higher is
required. The full iIWD/GRS compatibility matrix is here.

Install iWwD Runtime Node.

Install iwD Manager.

Create an iWD Tenant and iWD Solution in the iWD GAX Plugin.

Configure the necessary Integrated Capture Points for use with
iWD.

Related procedures and actions

Ensure that your environment meets the prerequisites. Ensure
that the required CDs are available. See Preparing for
Installation.

iWD 8.5 requires Interaction Server 8.1.1 or higher. Genesys
recommends that you use the latest version of Interaction
Server that is included with iWD. If your environment does not
have an instance of Interaction Server installed already (such as
for an eServices solution), you must install one. See Install
Interaction Server.

If it not already installed, you must install GAX. iWD
configuration is performed in GAX in release 8.5.0.

In Genesys Administrator Extension, install the iWD GAX Plugin
component, which is required to complete iWD configuration.
See Install iWD GAX Plugin.

Complete steps 1 to 6 (only) in the Task Summary: Installing
Genesys Rules System section of the Genesys Rules System
8.5 Deployment Guide.

Note: Step 7 in the Task Summary is about defining the
business structure, which is done in the iWD GAX Plugin.

Install Runtime Node and associate a Person account to the iWD
Runtime Node application. Install Runtime Node.

See Install IWD Manager.

See Creating the Tenant and Solution.

See eServices Integrated Capture Points Guide.
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Installation

Business Logic Configuration Phase Overview

Objective

Install and run the iWD Setup Utility to configure various
mandatory configuration objects.

Install iWD Stat Server Extensions.

Configure logging for iwD Manager and iWD Runtime Node.

Update the Interaction Server databases and Event Log DAP.

Configure remaining iWD services and objects.

Optional: Configure the system to start/stop application server
service through Genesys Solution Control Interface (SCI) or
Genesys Administrator.

Related procedures and actions

In release 8.5.0, iWD Setup Utility ships in the IP for iwD
Manager. See Install iWD Setup Utility.

See Installing the iWD Stat Extensions.

See Logging.
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Preparing for Installation

<tabber>

Installation Prerequisites=

Installation Prerequisites

¢ iWD 8.5.0 requires Genesys Administrator Extension version 8.5.000.47 or later.
* Tomcat web application server must be stopped. Stopping is optional for WebSphere Application Server.

e A supported web application server, such as Tomcat or WebSphere, must be installed on the
computer(s) on which iWD will be installed. For production deployments, install the iWD web
applications and the Genesys Rules System web applications on separate instances of the application
server.

e A supported database server must installed for the iWD Data Mart.

The following are required:
e OpenJRE 7 for Linux
e |IBM JDK 7 for Websphere
* IBM JDK 6 or 7 for AIX

* Oracle JRE 7 for Windows. Please see http://www.oracle.com/technetwork/java/javase/
downloads/index.html.

e For customers using Tomcat, Genesys only supports Java JDK 7. Java SDK can be downloaded from
http://java.sun.com/javase/downloads/index. jsp

Refer to the Genesys Supported Operating Environment Reference Manual for
supported platforms, Java application servers and database servers.

Support for RHEL 64-bit Platforms

Installers support installation of Red Hat Linux 64-bit platforms only when RHEL standard
compatibility packs for 32-bit platforms have been installed. These packages have generic names
like:

e compat-glibc*

e compat-libstdc++*
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e libstdc++* '

You might also need to ensure that the JAVA HOME variable points to the correct JDK.

WD DVD

This DVD contains the following components:

¢ iWD Runtime Node—Runs scheduled iWD Data Mart services.

* iWD Manager—A graphical user interface (GUI). iWD Manager is used for real-time management of
tasks. In 8.5.0 it also contains iWD Setup Utility, which is an XML file containing iWD-specific
configuration and setup information.

* iWD GAX Plugin—Business configuration of the iWD solution.

e iWD Stat Extensions—Stat Server Java Extensions that provide Stat Server clients, such as CCPulse+,
the ability to request and display current-day statistics from iWD’s Data Mart.

Configuration of Application Servers

It is necessary to configure your application server to successfully run iWD and the Genesys Rules
System. Apache Tomcat and IBM WebSphere are supported.

For production deployments, install the iWD web applications and the Genesys Rules
System web applications as separate application server instances, for improved
scalability and memory management.

|-| Installing on Tomcat=

Installing on Tomcat

If Tomcat is running as Windows service:

Add the following Java options to the Tomcat service configuration:
-XX:MaxPermSize=128m

-Dcom.genesyslab.platform.commons.connection.factory.class=com.genesyslab.platform.commons.conne
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For iWD Manager, configure the initial and maximum memory pools to 256 and 1024 megabytes.

If Tomcat is running as Windows console application:
Add the following to the setenv.bat file:

set JAVA OPTS=-XX:MaxPermSize=128m -Xms256M -Xmx1536M
-Dcom.genesyslab.platform.commons.connection. factory.class=com.genesys’

On UNIX machines:

Edit the setenv.sh file and add the following:

export JAVA OPTS="-XX:MaxPermSize=128m -Xms256M -Xmx1536M
-Dcom.genesyslab.platform.commons.connection. factory.class=com.
genesyslab.platform.commons.connection.impl.netty.NettyConnectionFacto!

setenv.sh and setenv.bat files:

By default, setenv.sh and setenv.bat files are not present after the installation of Tomcat, so you
need to create them manually under the Tomcat installation/bin directory and correctly configure
the access rights on UNIX machines properly for these files.

|-| Installing on WebSphere=

Installing on WebSphere

1. Log in to the WebSphere Integrated Solution Console.
2. Select Servers > Application Servers and select a server from the list.

3. Then continue to > Server Infrastructure, Java and Process Management > Process
Definition > Java Virtual Machine.

4. In Generic JVM Arguments, add these settings, if not present: -XX:MaxPermSize=128m
-Dcom.genesyslab.platform.commons.connection. factory.class=com.
genesyslab.platform.commons.connection.impl.netty.NettyConnectionFactory

5. Configure the initial and maximum heap size, using the same guidelines as for Tomcat.

6. If installing on WebSphere 7.0 or later, add this Generic JVM parameter:
-Dorg.ajax4jsf.cache.CacheFactory=org.ajax4jsf.cache.0SCacheCacheFactory

7. Restart the application server.

iWD Deployment Guide 26



Installation Interaction Server Configuration

Interaction Server Configuration

Interaction Server is required from iWD 8.1. If you are an existing eServices customer, and Interaction
Server and its databases are already installed and configured for your environment, you can proceed
with installing the iWD Runtime Node (Windows). Otherwise, please install Interaction Server by using
the procedures in the e-Services Deployment Guide.

A Multimedia Switching Office and Multimedia Switch must be created in Genesys Configuration
Database, to support Stat Server and URS operations. Refer to the eServices 8.1 Deployment Guide
for more details on these topics.

completed-queues

There is a specific Interaction Server configuration option named completed-queues that specifies a
list of queues for completed interactions. When an interaction is placed into one of these queues, the
CompletedAt timestamp is set for that interaction. This is also the timestamp that will be used to
calculate the Age of the interaction that is displayed on the Global Task List. This option, if it is not
already present, will be added for you automatically by using the Configure Ixn Custom
Properties feature of iWD Manager. However, this will only add the iWD Completed queue to the
option. You might want to add other queues to this option, based on how you want this Age to be
calculated. For example, you may wish to set it to: iWD_Completed, iWD Canceled, iWD Rejected

e Section: settings

e Option name: completed-queues

¢ Valid values: comma-separated list of queue names

enable-revoke-from-agent

Starting with Interaction Server 8.1.2, a configuration option, enable-revoke-from-agent, has been
provided to support enhancements to task management in the Global Task List. Specifically, this
option allows an Assigned interaction to be revoked from an employee desktop when the interaction
is put on hold, canceled, or completed, from the Global Task List or through an iWD capture point.
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Installing/Removing the IWD GAX Plug-in
(Including Language Packs)

iWD GAX Plugin and Language Packs are installed in the GAX standard way - the procedure is
described here (new document).

Notes on Localization

* The base GAX application and its plugins (including iWD GAX plug-in) are not fully separated with their
localization.

* All localization packages of all supported plugins and the GAX base localization package should be
installed together.

¢ All installed localization packages should contain the same set of languages.

Note on Removing the iIWD GAX Plug-in

If you perform the GAX Plug-in removal procedure for the iWD GAX Plug-in, you
need to make sure that following files have been deleted:

* <GAX HOME>/webapp/WEB-INF/1lib/gax-iwd.jar file (this should be removed by iWD
GAX uninstaller)

* <GAX HOME>/plug-ins/gax-iwd.jar file
e <GAX HOME>/webapp/plugins/gax-iwd directory

Note on Installing/Removing Language Pack Plug-ins

Before you perform the Installing Language Packs procedure for any iWD GAX
Plug-in language upgrade or after you perform the GAX Plug-in removal
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procedure procedure for Language Pack removal, you need to make sure that
following files have been deleted:

* <GAX HOME>/webapp/WEB-INF/1lib/gax-iwd-1lp-<lang-build>.jar (for example, gax-
iwd-1lp-de-de-8.5.000.02.jar file -this should be removed by iWD GAX language
pack uninstaller).

e <GAX HOME>/plug-ins/gax-iwd-1lp-<lang-build>.jar (for example, gax-iwd-1lp-de-
de-8.5.000.02.jar file).

e <GAX HOME>/webapp/plugins/gax-iwd-1lp-<lang> (for example, gax-iwd-1p-de-de
directory).
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Installing Genesys Rules System

Installing Genesys Rules System for Use with IWD

For production deployments, install the Genesys Rules System web applications (Genesys Rules
Engine and the Genesys Rules Authoring Tool) on a dedicated application server instance, apart from
the application server instance that is dedicated to the iWD web applications.

To install Genesys Rules System for use with iWD, complete steps 1 to 6 of the GRS
Installation Task Summary. Step 7 of the Task Summary is not required. For iWD
installations, you will create the business structure in the iWD GAX Plugin.

Configuring Rule Evaluation Order

In GRS 8.5.0, rules authors can change the sequence of rows in a decision table to permit more
sophisticated outcomes. So, you can specify whether the the rows in a decision table are processed
top-down or bottom-up by configuring a new option called evaluate-decision-table-rows-top-
down. See GRS Configuration Options.

Creating the Connection to Interaction Server

Create a connection by using the Connections tab in the Interaction Server Application to the
Genesys Rules Engine application. If GRE is configured as a cluster, add the GRE_Cluster application
on the Connections tab instead of the Genesys Rules Engine application.
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Installing Runtime Node

This section describes the procedures that are used to install iwD Runtime Node.
<tabber>

Prerequisites=

Prerequisites

The iWD Runtime Node must be installed as a standalone Java application server before it can run
iWD services. When deploying services for multiple solutions, each solution should have its own
dedicated runtime node.

¢ The environment meets the requirements that are described in Installation Prerequisites.

e The iWD DVD.

|-| Procedure=

Procedure

1. Log into Genesys Administrator Extension.
2. In GAX, create a new Database Access Point with type jdbc.
3. Manually install the application:

* On Windows—Locate and double-click setup.exe in the iWD Runtime Node directory of the iWD
DVD.

* On UNIX—As the iWD Runtime Node user, browse to the install directory and enter ./install.sh.

4. Navigate to Configuration > Environment > Applications and review the Runtime Node application
settings (which you have just set via the wizard).

5. The following changes might be required on the General tab:
a. For Linux, change the Working Directory to <iWD Runtime node installation directory> .
b. For Linux, change the Command Line to ./iWD Runtime.sh.
c. For Linux, change the Command Line Arguments to
-h cfgServerHost -p cfgServerPort -app iWDRuntimeNodeAppl
where:
e cfgServerHost is the host DNS name or IP where Configuration Server is running;

e cfgServerPort is the port of Configuration Server;
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h.

e iWDRuntimeNodeAppl is the IWD Runtime Node application name (which must not contain
spaces).

Certificate—The security certificate value. In Windows, select the certificate value from the list of
installed certificates. In UNIX, enter the full path to the <serial_#>_<host_name>_cert.pem file.

Certificate Description—An optional description of the Certificate.

Certificate Key—The full path to the <serial_#>_<host_name>_priv_key.pem file of the
security certificate key. This field is used only if Genesys Security is deployed on UNIX; otherwise
this field is empty.

State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

Login As Account—Select a user account that has full access to the relevant Tenant.

. On the Connections tab, add a connection to Interaction Server, Message Server and iWD Data Mart

DAP.

. In the Message Server DAP you will need to set the following fields to enable the Data Mart Load Config

job to connect to Message Server:

DB Info Tab -> Database

DB Info Tab -> DBMS Name Name

MSSQL The message server database

Oracle

DB2

name.
The database server name.
The message server database

SID.

The message server database

Th e rver name.
name. e database server name

. lgnore the Options tab.
. Click Save to save the Application object.

. Optionally, for UNIX, you can configure iWD Runtime Node as a UNIX service. For this you need to

update:

IWD USER
CS_HOST
CS_PORT
DM_APPL

in the iWD Data Mart Service Script.sh and add this script to the Services configuration.

|-| Create the Data Mart Database=
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Create the Data Mart Database

If you will be using the Genesys Interactive Insights for iWD product for historical
reporting based on the iWD Data Mart, you must enable several aggregates that are
not enabled by default. Please see the “Reading iWD Aggregation” section of the
Interactive Insights 8.1 Deployment Guide.

This is a general procedure. Work with your enterprise’s database administrator to follow the specific
procedure that is required by your database management system and your enterprise policies.
Prerequisites

¢ iWD Runtime Node must be installed

Procedure

Ensure that the database server is running.
Log on to the database server’s administrative interface (such as Oracle Enterprise Manager).
Create a new database user account (for example, iwddatamartuser).

Create a new database (for example, iwddatamartdb).

A

Ensure that there is a user, who has access to the Data Mart database, who has the following
permissions:

e CREATE TABLE

* CREAT INDEX

e CREATE VIEW

e CREATE TRIGGER (Oracle)
e CREATE SEQUENCE (Oracle)

The iWD Data Mart database will be initialized automatically the first time the Database Service and Kettle
ETL Service are started. If the Database Service’'s AutoSynchronize option is selected, this initialization is
automatic, and the Database Service will also check for updates to the iWD Data Mart database whenever a
new version of iWD Data Mart is installed. The AutoSynchronize option will also initialize ETL plug-ins.

|-| Add/Remove a Dedicated Message Server for iWD GAX Plug-in=
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Add/Remove a Dedicated Message Server for IWD GAX Plug-in

By default iwD GAX Plug-in uses GAX Message Server for auditing. However, as the amount of audit
message data generated by other Genesys applications can be huge, for better Data Mart
performance Genesys highly recommends configuring a Message Server dedicated to iWD.

Prerequisites

¢ iWD Runtime Node must be installed.

¢ A Message Server dedicated to iWD is installed, configured to work with the database, and running.

The Message Server dedicated to IWD needs to use the database server Database
Access Point (DAP)

¢ A corresponding Message Server application is created and configured in the Genesys configuration
environment.

All audit events from GAX's Message Server are processed by iWD Data Mart—for example, no
modifications of either Capture Points or Business Structure have taken place since Data Mart's last
successful Load Config job.

¢ No Data Mart jobs are running.

e iWD Runtime Node is stopped.

Add a Message Server dedicated to IWD

1. Navigate to Configuration > Applications.

2. Select the GAX application (of type Genesys Administrator Server).

3. Click on the Connections tab to open it.

4. Verify that only GAX's Message Server is displayed.

5. Click the Add button.

6. For the Server, choose the Message Server dedicated to iWD.

7. Click OK to add the new Message Server to the GAX application and close the window.
8. Verify that the newly added Message Server is on the list in the Connections tab.

9. Click Save.

10. Navigate to Configuration > Applications.
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11.
12.
13.
14.
15.
16.
17.
18.
19.
20.

21.

22.

Select the Message Server dedicated to iWD.

On the Application Options tab, add the role key in the GAX section with value of datamart.
Click Save.

Navigate to Configuration > Applications.

Select GAX's Message Server.

On the Application Options tab, add role key in the GAX section with value of gax.

Navigate to Configuration > Applications.

Select the iWD Runtime Node application.

Click on the Connections tab to open it.

Verify that only Message Server dedicated to iWD is displayed. If not then remove other Message
Servers (check the check box next to the Message Server and click Remove.)

If Message Server dedicated to iWD is not added than:
e Click the Add button.
* For the Server, choose the Message Server dedicated to iWD.

* Click OK to add the new Message Server to the GAX application and close the window.

Click Save.

Remove a Message Server dedicated to IWD

No v kA Ww NN oe

Navigate to Configuration > Applications.

Select the GAX application (of type Genesys Administrator Server).
Click on the Connections tab to open it.

Verify that there are two Message Servers—one for GAX and one for iWD.
Check the check box next to the iWD Message Server and click Remove.
Click Save.

Configure GAX's Message Server according to GAX Configuring the Auditing Feature (new
document).

* Navigate to Configuration > Applications.
e Select GAX's Message Server.
* On the Application Options tab, remove role key in the GAX section with value of gax.

e Click Save.

. Navigate to Configuration > Applications.
. Select the iWD Runtime Node application

10.
11.

Click on the Connections tab to open it.

Remove Message Server dedicated to iWD
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* Check the check box next to the Message Server and click Remove.

12. Add GAX's Message Server.
e Click the Add button.
* For the Server, choose the GAX's Message Server.

* Click OK to add the GAX's Message Server to the iWD Node application and close the window.

13. Click Save.

Post-procedure steps

1. Restart GAX.
2. Start iWD Runtime Node.
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Installing IWD Manager

<tabber>

[-]| On Windows=

Using GAX

1. Log into Genesys Administrator Extension.

2. Locate and double-click setup.exe in the iWD Manager directory of the iWD DVD. The iWD Manager
Installation Wizard opens. Click Next in the Welcome screen.

3. Select the web container (for example, Tomcat or WebSphere) and click Next.
4. If you selected WebSphere, select the appropriate JDK from the list.

5. If you selected Apache Tomcat, browse to the Home directory for your Apache Tomcat installation (for
example, C:\ProgramFiles\Apache\Tomcat60\). The iWD Manager components will be installed in the
selected directory, under the webapps/ subdirectory.

6. Click Next.

7. In the Connection Parameters to the Configuration Server screen, enter the login details to connect
to Genesys Configuration Server and then click Next:

¢ Host name—The host of Genesys Configuration Server

¢ Port—The port that is used by Genesys Configuration Server

e User name—The user name of the Person (or User) as defined in Genesys configuration.

¢ Password—The password that is associated with the Person (or User).

This is not the JDK which will be used by WebSphere. This is necessary to properly
configure the scripts which will be used to build the WAR archive.

Choose the destination location for iWD Manager. If you selected Websphere earlier, both supporting files
and iWD Manager Java application part will be installed in that location. If you selected Tomcat earlier, only
supporting files for iWwD Manager will be installation in that location. The iWD Manager web application will
be installed directly into the webapps folder under your Tomcat home directory.

After installation of iWD Manager and other iWD components, build the WAR archive as described in Post-
Installation Steps For WebSphere and install the generated WAR file by using WebSphere Integrated
Solutions Console. You can accept the default or browse to another location on your computer. Click Next.

Select the database type that will be used by the iWD Configuration database.
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e Enter the parameters that are used to connect to the iWD Configuration database in the next screen. Enter
the following information:
* DB Server Host—The name of the computer on which the database is located.
e Database Name—The name of the iWD Configuration database.
e User Name—The name of the user that is used to connect to the database.

* Password—The password that is used to connect to the database.

¢ Click Next.

e Enter the host name and port of the computer on which the backup Genesys Configuration Server is
running. If there is no backup Configuration Server in your environment, specify the primary Configuration
Server host and port. Click Next.

¢ In the Ready to Install screen, click Install to begin the installation of iWD Manager.
e When installation has been completed, click Finish.

e Optional step: Encode your database password. A file named passwordEncoder.cmd (or
passwordEncoder.sh for UNIX-based operating systems) file is included when you install iwD Manager.
This utility can be run to encode the database password that appears in the iwd.properties file, which is
located in <web application server directory>/webapps/iwd manager/WEB-INF/classes (the
password is in plain text in the iwd.properties file by default).

a. Open a Windows command-line window (go to Start->Run and enter cmd in the Run dialog box).

b. Navigate to the directory in which the passwordEncoder.cmd file is located (for example, cd
C:\Program Files\GCTI\iWDManager\passwordEncoder where the cd command is used to change the
directory).

c. Enter passwordEncoder <unencoded password> (for example, if the password is genesys you would
type in passwordEncoder genesys).

d. The command-line window will display the encoded version of the password.

e. Inthe iwd.properties file, replace the unencoded version of the password string with the encoded
version (iwd.configDatabase.password=).

f. Change the value of the iwd.configDatabase.passwordEncoded property to true.

g. Save the iwd.properties file.

Before/After Encoding the iwd.properties File

Below are two sample files. The first shows an iwd.properties file before the password was encoded. The example shows the same
file after the password was encoded.

In order for the password encoder to work, the JDK/JRE bin directory must be added to the PATH system environment variable. For
example, if the JDK is installed in C:\Java\jdk1.6.0_29 then C:\Java\jdk1l.6.0 29\bin should be in the PATH system environment
variable.

Sample file with unencoded password

iwd.configDatabase.url=jdbc:sqlserver://iwd80vm;databaseName=iwdmanagerdb
iwd.configDatabase.username=genesys

iwd.configDatabase.password=genesys

iwd.configDatabase.passwordEncoded=false
iwd.configDatabase.driverClassName=com.microsoft.sqlserver.jdbc.SQLServerDriver
iwd.configDatabase.hibernateDialect=org.hibernate.dialect.SQLServerDialect
iwd.configDatabase.type=mssql
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iwd.cfgServerHost=1localhost
iwd.cfgServerPort=2020
iwd.cfgServerBackupHost=1localhost
iwd.cfgServerBackupPort=2020
iwd.host=maestro 01

Sample file with encoded password

iwd.configDatabase.url=jdbc:sqlserver://iwd80vm;databaseName=iwdmanagerdb
iwd.configDatabase.username=genesys
iwd.configDatabase.password=Z2VuzZXN5cw==
iwd.configDatabase.passwordEncoded=true
iwd.configDatabase.driverClassName=com.microsoft.sqlserver.jdbc.SQLServerDriver
iwd.configDatabase.hibernateDialect=org.hibernate.dialect.SQLServerDialect
iwd.configDatabase.type=mssql

iwd.cfgServerHost=1localhost

iwd.cfgServerPort=2020

iwd.cfgServerBackupHost=1localhost

iwd.cfgServerBackupPort=2020

iwd.host=maestro 01.

Important

You can use other Base64 encoders to encode your password as well. These can be found easily on the Web. One
example is: http://www.motobit.com/util/base64-decoder-encoder.asp.

|-| Tomcat on UNIX=

On Unix

Purpose

To install the iWD Manager Application with Tomcat on the UNIX platform.

summary

Installation of iWD Manager saves the required database scripts in the working directory. These
scripts must be run against the iWD Configuration database and the Interaction Server database.

Prerequisites

e The web application server (such as Tomcat) is stopped.
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e The iWD Configuration database is accessible.

e The computer on which the iWD Manager is going to be installed has network access to the computer
that is hosting Genesys Configuration Server. Users of iWD Manager will be authenticated through
Genesys

Configuration Server.

* You have access rights to execute install.sh.

Procedure

1. At the root, browse to the install directory and enter ./install.sh.

2. When the following output is displayed., enter the required information, as indicated at each prompt.

Important

In this procedure Tomcat is selected for the servlet container.

Installing iWD Manager, version 8.5.xXxX.xx

Please select your servlet container type by number:

1. Tomcat

2. WebSphere

=>1

Please enter the full path to your

Tomcat installation =>/iwd85/iwd

Please specify the type of used Database Server:

1) MS SQL Server

2) Oracle Server

=>1

Please enter the Database Server hostname or IP address =>dbmssql
Please enter the Database name =>iwd850 config

Please enter the Database Server user name =>iwd

Please specify the Database Server user password =>

Please enter the Configuration Server Host Name =>mcr801l

Please enter the Configuration Server Port =>2020

Please enter the Configuration Server Backup Host Name =>mcr801
Please enter the Configuration Server Backup Port =>9090

Please enter full path of the destination directory for installation
=>/var/iwd85/manager

Extracting tarfile: data.tar.gz to directory: /var/iwd85/manager

webapp/

webapp/WEB-INF/
webapp/WEB-INF/application.properties
webapp/WEB-INF/web.xml
webapp/WEB-INF/faces-config.xml

webapp/WEB-INF/lib/
webapp/WEB-INF/1lib/hibernate.jar
webapp/WEB-INF/1lib/packagedstatisticsdeprecated.jar

webapp/WEB-INF/1ib/commons-lang. jar
webapp/WEB-INF/1ib/commons-logging.jar
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webapp/META-INF/MANIFEST.MF
Installation of iWD Manager, version 8.5.xxx.xx has completed
successfully.

|-| WebSphere on UNIX=

On WebSphere

Purpose

To install the iWD Manager Application with Websphere on the UNIX platform.

summary

Installation of iWD Manager saves the required database scripts in the working directory. These
scripts must be run against the iWD Configuration database and the Interaction Server database.

Prerequisites

¢ The Genesys configuration is accessible.

e The computer on which the iWD Manager is going to be installed has network access to the computer
that is hosting Genesys Configuration Server. Users of iWD Manager will be authenticated through
Genesys Configuration Server.

* You have access rights to execute install. sh.

The default JDK must be set to version 7.

Procedure

1. At the root, browse to the install directory and enter ./install.sh.

2. When the following output is displayed., enter the required information, as indicated at each prompt.

In this procedure Websphere is selected for the servlet container. When asked to provide the destination
directory, enter an arbitrary location. iWD Manager Java application and supporting files will be installed in
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this directory.

Installing iWD Manager, version 8.5.XXX.XX

Please select your servlet container type by number:

1. Tomcat

2. WebSphere

=>2

Please specify the type of used Database Server:

1) MS SQL Server

2) Oracle Server

=>1

Please enter the Database Server hostname or IP address =>dbmssql
Please enter the Database name =>iwd85 configuration

Please enter the Database Server user name =>iwd

Please specify the Database Server user password =>

Please enter the Configuration Server Host Name =>mcr801

Please enter the Configuration Server Port =>2020

Please enter the Configuration Server Backup Host Name =>mcr801-1
Please enter the Configuration Server Backup Port =>2020

Please enter full path of the destination directory for installation
=>/var/iwd85/manager

Extracting tarfile: data.tar.gz to directory: /var/iwd85/manager
acme/

acme/.gitignore

config/iwdbp.wie

\;vétlaapp/ui/images/se rvices/activeMQService.gif
webapp/help/whxdata/whglo. xml

Installation of iWD Manager, version 8.5.xxx.xx has completed
successfully.

|-| iWD Manager Application Definition=

Procedure

1. Navigate to Configuration > Environment > Applications and click New.
2. On the General tab:

a. Enter a name for the iWD Manager.

b. Select the application Template—this must of type iWD Manager.

c. Version, Tenant and Is Application Server boxes are pre-selected according to the template
type.

d. State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

3. On the Connections tab, add a connection to the Interaction Server that your iWD Solution will use. If
you need to:

a. Add the Port ID on the Interaction Server that iwD Manager will connect to.
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b. Specify the Connection Protocol: simple or addp.

c. Specify the Local Timeout and the Remote Timeout—These values are required only if you
specified addp in Connection Protocol. This value specifies the heartbeat polling interval, measured
in seconds, on a client side. This indicates how often the client application sends polling signals to
the server application. To enable this functionality, specify any integer as the value.

d. Specify a Trace Mode—The connection trace mode used between a server and its client.

* Trace Is Turned Off—Select if you do not want either the client or the server application to print
ADDP-related messages in its log.

e Trace On Client Side—Select if you want the client application to print ADDP-related messages in
its log.

* Trace On Server Side—Select if you want the server application to print ADDP-related messages
in its log.

* Trace On Both Sides—Select if you want both the client and server applications to print ADDP-
related messages in their log.

4. Specify Transport Protocol Paramters—Any text, usually key=value pairs, separated by a semicolon
(;). This property is application-specific.

5. Specify Application Parameters—Any text, usually key=value pairs, separated by a semicolon (;).
This property is application-specific.

The Ports tab lists communication ports used by the clients of an application to connect to a server. To
support specific high-availability configurations, more than one server can be registered on the same port
within the same host. Otherwise, do not assign the port number to any other server on the same host. Click
Add to add a connection.

Ignore the Options tab.
Ignore the Application Options tab.

Click Save to save the Application object.

|-| Post-Installation Steps for WebSphere=

Post-Installation Steps for WebSphere

After the installation of iWD Manager it is necessary to build the WAR archives and install them into
WebSphere using Integrated Solutions Console.

Building WAR archives for iIWD Manager (Windows)

1. Browse to the directory which was specified during installation of iWD Manager and continue to
subdirectory \webapps.

2. Launch the iWD Manager.bat file. This will create the iwd manager.war file.
3. Log in to Websphere Integrated Solutions Console.

4. Uninstall the existing iWD Manager applications, if they are present.
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5. Install iWD applications, and select the prepared WAR files when prompted.

6. When installation is completed, adjust the order of classloaders for each installed iWD application. By
default, classloader order is Parent first, then Application. iWD requires the order to be Application first,
then Parent.

7. To change the order of the classloaders, in WebSphere Integrated Solutions Console, click on
Application, click Manage Modules, click on Module (one per application), then change the
classloader order to Application, then Parent.

8. Click Save.
9. From the installed application list:
1. Click on the application.
2. Click on the [JSP and ]JSF options] link.

When deploying on Websphere 8.x, the JSF implementation must be set to SunRI1.2 for the iwd_manager
application.

3. Select SunRI1.2 from the drop-down list.
4. Click Save.

10. Start the application.

Building WAR archives for iIWD Manager (UNIX)

1. Browse to the directory which was specified during installation of iWD Manager and continue to
subdirectory webapps/.

2. Launch the iWD Manager.sh file. This will create the iwd manager.war file The following output will be
displayed:

bash-3.00# cd /var/iwd85
bash-3.00# 1s

manager

bash-3.00# cd manager/webapps
bash-3.00# 1s

iWD Manager.sh iwd manager
bash-3.00# ./iWD Manager.sh
added manifest

z.ac.icliing: ui/lib/codepress/images/line-numbers.png(in = 16556) (out=

16556) (stored 0%)
bash-3.00#

3. Log in to Websphere Integrated Solutions Console.
4. Uninstall the existing iWD Manager applications, if they are present.

5. Install iWD applications, and select the prepared WAR files when prompted.
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6. When installation is completed, adjust the order of classloaders for each installed iWD application. By
default, classloader order is Parent first, then Application. iWD requires the order to be Application first,
then Parent.

7. To change the order of the classloaders, in WebSphere Integrated Solutions Console, click on
Application, click Manage Modules, click on Module (one per application), then change the
classloader order to Application, then Parent.

8. Click Save.
9. From the installed application list:
1. Click on the application.
2. Click on the [JSP and ]JSF options] link.

When deploying on Websphere 8.x, the JSF implementation must be set to SunRI1.2 for the iwd_manager
application.

3. Select SunRI1.2 from the drop-down list.
4. Click Save.

10. Start the application.

|-| Configuring Localized Help=

Configuring Localized Help

Changes to iwd.properties File

For both Tomcat and Websphere you must update the iwd manager\WEB-INF\classes\
iwd.properties file in order to enable the Help topics to display in the correct language. The
language locales are defined as follows:

e de-de—German

¢ es-la—Spanish (Latin American)

e fr-fr—French (France)

e pt-br—Portuguese (Brazilian)

¢ zh-cn—Chinese (Simplified)

Examples

English
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1. iWD Help base URL
iwd.help.url=http://docs.genesys.com/Special:HelpLink/iWDManagerHelp?context=

2. iWD Help locale (language). Leave empty to use default (English).
iwd.help.locale=

3. iWD Help version. Leave empty to generate automatically. Examples:
#iwd.help.version=default

#iwd.help.version=8.5.0
iwd.help.version=

German

1. iWD Help base URL
iwd.help.url=http://docs.genesys.com/Special:HelpLink/iWDManagerHelp?context=

2. iWD Help locale (language)
iwd.help.locale=de-de

3. iWD Help version. Leave empty to generate automatically. Examples:
#iwd.help.version=default

#iwd.help.version=8.5.0
iwd.help.version=

Next Steps

* WebSphere—Rebuild and redeploy iwd manager.war (using the procedure in Post-Installation Steps
for WebSphere).

¢ Tomcat—Restart
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Enabling/Disabling ADDP Connections

1. After installation, navigate in GAX to Configuration > Environment > Applications.
2. Locate the iWD Manager or Runtime Node in the list and open it.

3.
4

Select the Connections tab and then select the server connection you want to change.

. Open it and select addp from the Connection Protocol drop-down options.
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Creating the (Tenant and) Solution in IWD
GAX Plugin

After the IPs are installed, you must create an iWD solution in iWD GAX Plugin to
proceed with the configuration of iWD. It is most unlikely that you will need to create a
new Tenant, but instructions for this are included anyway.

It is recommended that you do not create any Solutions and Services under the
System Tenant. You should do so under a managed Tenant.

Procedure

1. Login to iWD GAX Plugin.
2. Navigate to Environment > Tenants.

3. Click New to open a configuration page. This has fivetabs: General, Options, Permissions,
Dependencies and iWD Attributes.

4. Enter the following information. For some fields, you can either enter the name of a value or click
Browse to select a value from a list: General tab

« Name—The name of the Tenant. You must specify a value for this property, and that value must be
unique within the Configuration Database.

* Password—A password that must be used to access this Tenant.
* Confirm Password—A confirmation of the password.

* Parent Tenant—The parent Tenant of this Tenant. By default, the parent Tenant is the Tenant in
which you are creating the new Tenant. If you change this field, the new Tenant will be created as a
new child Tenant under the specified parent Tenant. To subsequently change the parent Tenant,
refer to the Structure tab, above.

* Chargeable Number—The account number to which activities for this Tenant are charged, for cost-
tracking purposes.

* Default Contract—The default cost contract applied to resources of this Tenant. For more
information, refer to the Routing Solutions chapter of the Universal Routing 8.0 Routing Application
Configuration Guide.

» State Enabled—If selected, indicates that the object is in regular operating condition and can be
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used without any restrictions.
* Ignore the Options tab.
Permissions

5. Configure user permissions for this Tenant.
Dependencies

6. Configure any Dependencies for this Tenant.
iWwD Attributes

7. Configure the iWD Attributes for this Tenant.

e ID—The Tenant's runtime ID, generated automatically.

e Description of the tenant.

¢ Social Messaging Enabled—Check to enable social engagement integration for this Tenant.
* Rule Authoring Tool URL—The URL of the Genesys Rules Authoring Tool for this iWD Tenant.

e Click Inventory Report to print to screen a complete view of the Tenant hierarchy, including Solutions,
Departments and Processes.

e Add any Custom Tenant attributes by clicking Add and filling in the Name Type and Value table.

If you are not logged in as the default User, or are not a member of the
SuperAdministrators Access Group, you must have special permissions and role
privileges to create a Tenant. Refer to the Genesys 8.1 Security Deployment
Guide for details about the security requirements for creating a Tenant.

Next Steps

Configure your IWD Soluton by installing and running the iWD Setup Utility. Create as many iWD
solutions as are required for your business needs. Each iWD solution requires its own dedicated Stat
Server. For each iWD solution that you you create, run the iWD Setup Utility and install the Stat
Server Java Extension.

Each iWD solution requires its own iWD Data Mart.
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Working with Integrated Capture Points

Capture point (CP) functionality allows iWD to create new tasks, based on data coming from an
enterprise application or source system. CPs also enable existing tasks to be canceled, completed,
held/resumed, restarted, or modified. CP functionality is integrated into Interaction Server.

However, for customers upgrading from iWD 7.6.1 or 8.0, iWD 8.5 no longer supports the legacy CPs
services from those releases.

Genesys recommends that you use the Integrated CPs (ICPs). Because iWD 8.5 no longer supports
legacy capture points, you will need to migrate to using ICPs. See the Moving from Legacy to ICPs tab
on this page.

Installing IWD ICPs

Installing IWD Integrated CPs

Installation procedures for ICPs are described in the eServices Integrated Capture Points 8.1 Guide.

Remember that legacy capture points are not supported in iWD 8.5.

The prerequisites and other information will differ in the eServices 8.1 Deployment Guide, depending
on the ICP being used. However, for all ICPs there are two common installation steps:

¢ Creating the Capture Point application.

e Configuring Capture Point iWD attributes.

Creating a Generic Capture Point

Creating a Generic Capture Point

The procedures in this section are applicable to all types of Capture Point. Differences in configuration
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between pre-8.5 ICPs are mentioned specifically in the procedures are documented in the e-Service
Capture Point Guide.

Creating the Capture Point application

Purpose

¢ The Capture Point functionality is built within Interaction Server 8.1, which means that there is no
separate installation package for any type of Capture Points. An Application object for the Capture
Point must be configured in GAX. One Application must be configured for each instance of the
Capture Point. Interaction Server supports multiple capture points.

Prerequisites

¢ Interaction Server must be installed.

¢ iWD 8.5 must be installed.
Start

1. Login to GAX.
2. Navigate to Environment > Applications.

3. Create a new Application object based on the chosen Capture Point template. The CapturePointId
will be automatically set to the name of the Capture Point application as configured in GAX. In iWD
compatibility mode, it will also be saved as the IWD capturePointId property in user data. When the
Capture Point is configured, the Capture Point ID must be the same as the application name in order to
ensure accurate events history reporting and accurate filtering. (The Capture Point Name can be
anything).

The name of the Capture Point Application must start with a letter, contain only
alpha-numeric characters and underscores, and cannot be longer than 16
characters and cannot contain spaces.

4. Because the Capture Point is integrated with Interaction Server, the Host and Port information is taken
from Interaction Server (which must be listed as a connection on the Connections tab). Host and Port
information comes from Interaction Server.

5. Add a connection to Interaction Server. Multiple Capture Point Application objects can connect to the
same Interaction Server.

On the Ports tab, add any additional ports required for connection to Interaction Server.
On the Tenants tab, add the relevant Tenant.

Ignore the Options tab.

o o N o

Ignore the Application Options tab.

10. On the iWD Attributes tab, select the Solution from the drop-down list and add a Description. The
runtime ID of the capture point is generated by GAX by default from the Solution's Tenant runtime ID.
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11. Save the Application object.

12. When configuration is complete, click Save.

End

Moving from Legacy to ICPs

Moving from Legacy to ICPs

Mapping Native IWD Task Actions to Native IXS Message

Operations

This section is intended to help you understand how the native Interaction Server (I1XS) XML message
operations compare to the native iWD XML message operations. The information provided here is

mainly derived from the eServices 8.1 User's Guide.

This page shows how the operations you would specify in the iWD message format correspond, or
translate, to the operations you would specify in the IXS message format.

Task action

Create a new task/interaction in iWD

Get information about a task/interaction
in iWD

Update a task/interaction in iWD

Complete a task/interaction in iWD

Hold a task/interaction in iWD

Resume a held task/interaction in iWD

Restart a task/interaction in iWD

iWD XML message operation

CreateTask

GetTaskInfo

UpdateTask

CompleteTask

HoldTask

ResumeTask

RestartTask

Interaction Server message

<interaction

<interaction

<interaction

<interaction

<interaction

<interaction

<interaction

operation

operation="submit">

operation="getinfo">

operation="update">

operation="update">

operation="hold">

operation="resume">

operation="update">

iWD Deployment Guide

52



Installation Working with Integrated Capture Points

Interaction Server message

Task action iWD XML message operation operation

Cancel a task/interaction in iWD CancelTask <interaction operation="update">

Creating a New Task or Interaction

When you are creating a new task/interaction by using the <interaction operation="submit">
operation to specify the all initial properties of the interaction, use the properties element,
which is a direct child of the interaction element. Alternatively, you can provide default values for
any interaction properties, as part of the Integrated Capture Point Application configuration. See
the descriptions of the default-values sections (which are repeated for each capture type) in the
eServices 8.1 Reference Manual.

Configuration of some properties is mandatory to ensure iWD behaves as expected. Also, in Task
Attribute Mapping in the columnInteraction Attached Data Key, the names of the properties are
described as you would refer to them in this message. You can cross-reference this with the
information in the tables titled Translation Table for Known Attributes-Inbound and
Translation Table for Known Attributes-Outbound in the eServices 8.1 User's Guide.

Updating, Completing, Canceling, or Restarting a Task/Interaction

Use the <interaction operation="update"> operation when you are updating, completing,
canceling, or restarting a task/interaction. Use the properties element, which is a direct child of the
interaction element, to specify which properties to update.

In the special cases, when you are completing, canceling, or restarting a task/interaction, specify the
Queue property, to move the task/interaction to the iWD Completed queue, iWD Canceled queue,
or the iWD New queue, respectively.

When you use the iWD Completed, iWD Canceled, and iWD New queue names, it is
assumed that you are using the out-of-the-box business process that is provided with
iWD (IWDBP). If you have modified this business process to add/change queue names,
you will need to consider this when you are specifying the Queue property for the
update action.

Mandatory Interaction Properties

When you submit a new interaction to Interaction Server (<interaction operation="submit">), the
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following properties are mandatory. Therefore, they are also mandatory for the Integrated Capture
Points:

e InteractionType

e InteractionSubtype

e MediaType

¢ Queue

TenantID

In this case, TenantID is the Genesys tenant ID, not the ID of the managed tenant
that is created in the iWD configuration.

You do not need to specify these properties in the XML message, because several of them are
normally not relevant to iWD. There is an configuration option for the Capture Point Application
template, called default-values (for a description, see the eServices 8.1 Reference Guide), which
enables you to enter default values for any of these properties (as well as any other interaction
properties). Therefore, if the default values for these five attributes/properties are specified in the
options, then the message itself need not contain any other properties for Interaction Server to
accept and process it.

The Queue property is an exception, because you can configure the default queue as part of the
business process configuration by using the endpoints section.

In addition to these mandatory properties, three other properties, specific to iWD interactions, are
used to ensure that interactions are accounted for correctly by iWD Data Mart and are displayed
properly through the Global Task List. The properties are:

e iWD TenantId
e iWD SolutionId
e iWD CapturePointId
The iWD CapturePointId property will be equivalent to the name of your Capture Point

Application in Configuration Server. See the procedure, “Creating the capture point application” in
the eServices 8.1 Deployment Guide.

When you deploy the Integrated Capture Point, you must also set the ID and Solution on the iWD
Attributes tab.

The iWD SolutionId and the iWD TenantId properties are the ID of the Solution and the Tenant,
respectively, under which the capture point application has been created in GAX. Similar to the
mandatory interaction properties, these three additional properties are set automatically by the
iWD GAX Plugin when the iWD Attributes tab is completed.
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More Information About CPs

More Information About CPs

For a description of some optional ways to format the information inside the <properties> element,
see the section, “Properties Element” in the eServices 8.1 User's Guide.

For additional information about other elements, such as changed, deleted, reason, actor, and
party, and about how responses to capture point requests are processed, see Chapter 9 in the
eServices 8.1 User's Guide.

By default, when you specify any interaction property that is not considered a core property of the
Interaction Server interaction data model, or that is not a core or extended attribute in terms of the
iWD data model, the value of that property will be stored in a BLOB in the interactions table of the
Interaction Server database. If you need to use this custom property in any Queue Views, or to use
filtering in the Global Task List, see the Working with Task Attributes and Interaction Properties
document.
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(WD Setup Utility

Overview

Overview

In release 8.5.0, the Setup Utility does not ship in a separate IP. It ships as part of iWD
Manager IP.

The iWD Setup utility performs the following functions:

¢ Imports iWD business processes to Genesys Configuration Server. The iWD Setup Utility includes the
following business processes:

* IWDBP—the default business process. See Working with the iWD Business Process (IWDBP) -
8.1.document.

* Standard Genesys to IWD adapter—the business process used to insert into IWDBP to serve Genesys
standard open media channels. These business processes are also provided as a .wie file that can
be imported manually through the Genesys Interaction Routing Designer. This is useful when you
are upgrading from one iWD release to another and you do not have to run the iWD Setup Utility.

The iWD business process .wie file is saved to your file system when the iWD Manager Installation
Package is installed.

* ABC IWD Simple BP—the business process used to insert into existing business processes.

Creates an Agent Group called IWD in your Genesys Configuration Database. This is the name of the
Agent Group that is used in the example Distribution routing strategy that is included in the standard
iWD Business Process (IWDBP). Although all customers are expected to modify this Distribution routing

strategy for their own needs, having the IWD Agent Group created out of the box will make it easier to
use IWDBP to process interactions for testing purposes.

Creates the capacity rule that includes the media type workitem and provides the option to assign it to
the Tenant.

Enables you to select and configure the Stat Server to use with iWD Stat Extensions.
Configures the iWD Stat Server Java Extensions into the specified Stat Server.

Creates the two List Objects—Iwd Esp List and Iwd Package List—that are necessary to ensure
business rules are invoked from business processes, such as IWDBP.
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Iwd Esp List also defines the list of Universal Contact Servers to be used with
Interaction Server that allow the iWD business process (IWDBP) to update the
interaction record in the Universal Contact Server, to mark the interaction as done.

¢ Creates the connector objects for the iWD solution.

Installing and Using the Setup Utility

Installing and Using the Setup Utility

This procedure configures the objects required in Configuration Server for your iWD installation.

The iWD Setup Utility can be run multiple times, as it is possible to have multiple iwWD Solutions in your
environment. The following procedure outlines the steps taken the first time the utility is run. Subsequent
runs of the utility may result in some screens not being displayed, as the information has already been
configured. Therefore, when you run the iWD Setup Utility it might not follow the exact procedure outlined
below.

The iWD Setup Utility will not over-write the iWD business process if it has already been imported by a
previous run of the iWD Setup Utility. So, if any customization has been made on the business process,
running the iWD Setup Utility will not impact your customization, provided all strategy names are the same.

If you have made changes to the iWD business process, but would like to see the
business process that is included in the iWD Setup Utility, you must export the
customized business process from IRD, delete it, and then run the iWD Setup Utility
again. Or, you can run the iWD Setup Utility against a different Tenant.

Prerequisites

iWD Manager is installed (iWD Setup Utility is shipped with the iWD Manager IP).

¢ iWD Runtime Node is installed.

The iWD Data Mart has been installed and the iWD Data Mart database has been created.

Interaction Server 8.0.1 or later has been installed. If you are not an existing eServices customer, you
will need to install an instance of Interaction Server to use with iWD.
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Procedure

1. In GAX, navigate to Administration > Solution Definitions.

2. Click on the + button.

3. In the New window, click the Choose File button.

4. Navigate to the iWD installation directory; for example—C:\Program Files (x86)\GCTI\iWD Manager\

config\ASD—and select the iWD setup utility.xml file.

5. When you have uploaded it successfully, the iWD Setup Utility option will become available for
selection.

6. Select iWD Setup Utility from the displayed list. Your screen should look like this:
Solution Definitions < 2 iIWD Setup Utility L X

Q ] m + o Downboad Delete @

H e Descriplion Ver... Dép.... Vesion

B 50001
v @@ Enviranment 8.5.000.19

Descaphon
oh WD Setup Lility Ths file defines a ... B5.00.. —r
his file defines & wizard 1o configure the intelligent
Workload Distnbution (WD) Solution

Noles

Group

Deployable @

Solution Defnition
Choose File | Mo file chosen

7. Check the Deployable check box. If for any reason your Setup Utility is not deployable, you will be
prompted at this point.

8. From the Settings menu (indicated on the screen above) select Install. This action opens the
Automated Service Deployment Wizard, which is a sequence of configuration screens in which you will
define your iWD solution instance. Click Next to begin deployment. Deloyment consists of the
following:

a. Tenant Selection—Browse and select the Tenant where you plan to install the iWD Solution
components.

b. Multimedia Switch Selection—Add the name of a multimedia switch if appropriate. A Multimedia
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Switching Office and Multimedia Switch must be created in Genesys Configuration Database, to
support Stat Server and URS operations. Refer to the eServices 8.1 Deployment Guide for more
details on these topics.

c. Universal Router Server Selection—Select the URS for this iWD Solution.

d. Samples Placement—Enter the name of the directory where routing strategy files for sample
import will be placed.

e. Resource Capacity Rules Selection—To select the capacity rule. This action will create a capacity
rule that can be used immediately.

The default capacity rule that will be created by the iWD Setup Utility will be based on the media type
workitem. You are not required to use workitem as the media type. You can create new media types in
Configuration Manager or Genesys Administrator (as Business Attribute objects) and you can use the new
media types in any Capture Points you create, as well as in any capacity rules you configure.

f. Interaction Server Selection—Browse to and select the Interaction Server you plan to use to
process interactions for this iWD Solution.

g. Database Access Point Selection—Browse to the Database Access Point that is configured for
the Interaction Server Event Log database, or create a new one if necessary.

h. Stat Server Selection—Select an existing Stat Server to configure the iWD Stat Server Java
Extension for this solution.

Each iWD Solution requires its own dedicated Stat Server. For more information about installing and
configuring Stat Server, refer to the Framework 8.1 Stat Server Deployment Guide.

i. Universal Contact Server Selection—Select an existing UCS to use with this iWD Solution. If this
does not exist, you can skip this step. Having the Universal Contact Server name associated with
your iWD Solution ensures that the business logic in the out-of-box iWD business process (IWDBP)
will update the interaction record in the UCS database when an interaction is considered done (that
is, the value of the Status column in the Interaction table in the UCS database will be set to 3).
Normally such an update is done in a routing strategy when processing is stopped for an interaction
and the interaction is deleted in the Interaction Server database. However, in the case of the iWD
business process, even though interactions may persist in the Interaction Server database for a
long period of time, they should still be considered done from an interaction history standpoint in
the UCS database. Selecting a Universal Contact Server application on this screen will cause the
iWD Setup Utility to update the Iwd Esp List list object with an association between your iWD
Solution name and this UCS application name.

j. iIWD Manager Creation—Add the name of the iWD Manager application, and browse and select
the parent applications folder where the iWD Manager application is located.

k. Genesys Rules Engine Application Selection—Browse and elect an existing Genesys Rules
Engine, or cluster, to evaluate iWD rules.

|. iWD Solution Selection—Enter the enter the Solution ID for the solution.
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Stat Server Extensions

After the iWD Setup Utility has completed, you can install the iWD Stat Extensions, which provide
access to the aggregated data in the Data Mart.

Installing Stat Server Extensions

Installing Stat Server Extensions

If the Data Mart is not used, Stat Extensions are not required and the solution will
work fine.

Prerequisites
¢ An instance of Stat Server is installed, dedicated for use with iWD. Refer to the Framework 8.1 Stat
Server Deployment Guide for more information.
Procedure

Log into Genesys Administrator Extension.
Navigate to Administration > Installation Packages.

Click the + button to add a new Installation Package (IP).

A W N =

In the Software Installation Wizard panel, select the Installation Package Upload (includes
templates) option and click Next.

5. Upload a package > Choose File field, browse to the iWD Stat Extensions IP on the software CD,
select teh correct IP, and click Finish.

6. When the IP is uploaded successfully, it appears in the displayed list. To install it, click on it. Its details
appear in a new panel.

7. Verify the details of the IP, then click the menu button and select Install.
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8. Navigate to Configuration > Environment > Applications and click New.
9. On the General tab:

a. Enter a name for the iWD Runtime Node.

b. Select the application Template—this must of type Stat Server.

c. Add the Working Directory of the Stat Server for the extensions

d. On the Connections tab, add a connection to iWD Stat Server and to iWD Data Mart.

Stat Server Configuration Options

Stat Server Configuration Options

The required Stat Server configuration options will already be configured if you have used the iWD
Setup Utility and installed iWD Stat Extensions. Each option is described briefly below.

Java-extensions section

During installation, a new option is added to the java-extensions The option
BPR iWD Extension.jar is added with a value of true.

Java-extensions-bpr-iwd section

The java-extensions-bpr-iwd section contains options which specify the JDBC connection driver
and parameters for access to the iWD Data Mart database. The only option whose value shouldn't be
changed under normal circumstances is java-extension-jar. The value of this option is the name of
the BPR iWD extension jar-file. The rest of the options are described briefly below:
e jdbc-driver: The class name for the corresponding JDBC driver. Valid values include:
e com.inet.tds.TdsDriver (for MS SQL)
e com.inet.ora.OraDriver (for Oracle)

e com.mysql.jdbc.Driver (for MySQL)

¢ jdbc-url: The JDBC URL, which describes RDBMS-specific access parameters. Below are some sample
values:

e jdbc:inetdae7:hostname:1433?database=databasename (for MS SQL)

e jdbc:inetora:hostname:1521:databasename (for Oracle, if you are using the instance name of the
database)

* jdbc:inetora:hostname:15217?service=<Service ID> (for Oracle, if you are using the network
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service name of the database)

* jdbc:mysql://hostname:3306/databasename (for MySQL)

e user: The user name for database access.
e password: The password for database access.

e verbose: The level to control debug information, provided in the Stat Server log file. Possible values are
debug, trace, or standard.

e refresh-interval: The interval (in minutes) for data updates from database.
e service-id-1: The runtime ID of the Statistics Adapter service in the iWD configuration.

e service-tenant-1: The name of the CME tenant, that is linked to the iWD managed tenant where the
Statistics Adapter service is configured.

e tenant-ids: A list of Configuration Server/Genesys Administrator tenant names mapped to iWD tenant
IDs, separated by a comma. For a system with one tenant with name TenantA and ID T2, this option
should be set to value:Environment=1, TenantA=2

Report Stats for each Dimension on its own Virtual Queue

Report Stats for each Dimension on its own Virtual Queue

The iWD Stat Server Java Extension can be configured to report statistics in two different ways: all
statistics for all dimensions can be reported on one Virtual Queue, or each dimension can have its
statistics reported on its own Virtual Queue.

The iWD Setup Utility configures Stat Server to use the iWD Stat Server Java Extension to report all
statistics on one Virtual Queue. If you want to change this, you have to modify the configuration

manually.

Procedure

To report each dimension on its own Virtual Queue:

1. Set the the option dimension-mapping-1 to the value Virtual Queue.

2. Instead of using the Virtual Queue name as a value for the option virtual-queue-name-1, indicate the
prefix that will be used for Virtual Queue names. For example, if virtual-queue-name-1=dim-, then
Virtual Queues with the names dim-CNT T2 C106, dim-CNT T2 C107 and so on, have to be created.

iWD Deployment Guide 62



Installation Logging

Logging

iWD Manager and iWD Runtime Node support creation of their own log files for troubleshooting
purposes. As well, they both support centralized logging through Genesys Message Server. The
parameters needed for both types of logging are configured in the log4j.properties file for each
application. The following procedures explains how to configure the required parameters.

Configuring logging for IWD Manager and iIWD Runtime Node

Configuring logging for IWD Manager and iIWD Runtime Node

Prerequisites

e iWD Manager and iWD Runtime are both installed.

* For centralized logging, Genesys Message Server is installed.

Refer to the Framework 8.1 Management Layer User’s Guide for more information about Message
Server.

Start

1. Find the log4j.properties file in the web application server’s (Tomcat or WebSphere) webapps
directory and open it in a text editor.

For WebSphere, the file is located under WAS root/
profiles/<profile>/installedApps/<node,cell>/
<application> war.ear/<application>.war/WEB-INF/classes

Example: /usr/IBM/WebSphere/AppServer/profiles/AppSrv0l/installedApps/
rs6000Node01Cell/iwd manager war.ear/iwd manager.war/WEB-INF/

classes

2. The exact path is <Install dir>\iwd node\config\log4j.properties for iWD Runtime Node and
webapps\iwd manager\WEB-INF\classes\log4j.properties for iWD Manager.
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Be sure to remove the comment symbol (#) when you update the parameters.

3. For centralized logging, update the very first row of the log4j.properties file to include
centralized node at the end:

log4j.rootLogger=INFO, runtime, centralized node

For centralized logging, update the following parameters with the Message Server host and Message Server
port, respectively:

log4j.appender.centralized manager.MessageServerHost=[ToBeChanged:MS

log4j.appender.centralized manager.MessageServerPort=[ToBeChanged:MS

Update the following line to include the name of your iWD Manager or iWD Runtime application (this is the
application name that you must use to set up alarms in Solution Control Server):

log4j.appender.centralized node.MessageServerClientName=iWD
Runtime Node

Configure the parameter to specify the level of logging to send to Message Server:

log4j.appender.centralized node.Threshold=INFO
Threshold can be set to any of the following values:

* TRACE
» DEBUG
* INFO
* WARN
* ERROR

For information about various settings for the root logger, refer to log4j framework docs, such as
http://logging.apache.org/log4j/1.2/manual.html.

You can change the directory where the logs will be written by changing the value of this line:

log4j.appender.runtime.File=C:/GCTI/iWD/iwd runtime.log

It is strongly recommended that you only set the file path to a directory on a local
machine, not a remote location such as a shared network drive. Logging to a remote
location can severely impact performance
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file):

¢ You can change the logging level by changing this line (sample is from an iWD Runtime log4j.properties

log4j.appender.runtime.Threshold=INFO

Possible values are 0ff, Warning, Error, Debug, Info, and Trace . See Service Log Levels for a
description of each log level.

* You can change the maximum file size of the logs by changing this line:

log4j.appender.runtime.MaxFileSize=256MB

e Save your changes.

The following is a sample iWD Runtime log4j.properties file configured for logging:

info, rolling 256MB each (2 GB max)

log4j.rootLogger=INFO, runtime, centralized node

log4j
log4j
log4j
log4]j
log4j
log4j
log4j
log4j
log4j
log4j
log4j

log4j
dd HH:

log4j.

.category.
.category.
.category.
.category.
.Ccategory.
.category.
.category.
.appender.
.appender.

.appender.

org.
org.
org.
org.
org.
org.

org.

apache.myfaces.renderkit.html.util=ERROR
hibernate.util.JDBCExceptionReporter=FATAL
hibernate.event.def.AbstractFlushingEventListener
apache.commons.httpclient=ERROR
apache.commons.digester=ERROR
codehaus.xfire.transport.http.HttpChannel=FATAL

codehaus.xfire.handler.DefaultFaultHandler=ERROR

runtime=org.apache.log4j.RollingFileAppender

runtime.Threshold=INFO

runtime.File=C:/GCTI/iWD/iwd runtime. log

.appender.runtime. layout=org.apache.log4j.PatternLayout

.appender.runtime. layout.ConversionPattern=%d{yyyy-MM-

mm:ss}|%t|%p|%cC|%m%sn

appender. runtime.MaxBackupIndex=7
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log4j.appender.runtime.MaxFileSize=256MB

if you enable centralized node appender then make sure you
change rootLogger to:

log4j.rootLogger=INFO, runtime, centralized node
log4j.appender.centralized node=com.genesyslab.iwd.log.CentralizedAg
log4j.appender.centralized node.Threshold=INFO
log4j.appender.centralized node.layout=0rg.apache.log4j.PatternLayou
log4j.appender.centralized node.layout.ConversionPattern=%m
log4j.appender.centralized manager.MessageServerHost=MsgSrvrHost
log4j.appender.centralized manager.MessageServerPort=4050

log4j.appender.centralized node.MessageServerClientName=iWD
Runtime Node

End

Updating the Interaction Server databases and related
configuration objects

Updating the Interaction Server databases and related
configuration objects

Purpose

To ensure iWD automatically runs the update scripts on the Interaction Server databases for
compatibility with iWD 8.1, updates the configuration options for the Event Log DAP, creates the
necessary Business Attributes in Configuration Server, and configures the completed-queues option
for Interaction Server.

Prerequisites

¢ Interaction Server is installed as described in Installing Interaction Server and its databases (also refer
to the eServices (Multimedia) 8.1 Deployment Guide).
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e The installation of iWD components as outlined in this chapter is completed up to this point. In
particular, iWD Manager must be installed.

Start

1. Log into iWD Manager.
2. Navigate to your iWD tenant.

3. Navigate to the Configure Ixn Custom Properties tab and select your solution from the navigation
tree

4. Select Configure Ixn Custom Properties.
The Mapping errors section on the right-side pane notifies you of the updates that must be
made to your Interaction Server Event Log DAP and Business Attribute configuration. The
Interaction Server and Event log database migrations section notifies you of the

updates that must be done to your Interaction Server and Interaction Server Event Log
databases.

5. To initiate these updates, click Configure Ixn Custom Properties.

You are prompted to restart Interaction Server.

End

enable-revoke-from-agent

Starting with Interaction Server 8.1.2, a configuration option, enable-revoke-from-agent, has been
provided to support enhancements to task management in the Global Task List. Specifically, this
option allows an Assigned interaction to be revoked from an employee desktop when the interaction
is put on hold, canceled, or completed, from the Global Task List or through an iWD capture point.
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Preparing IWD For Use With Genesys Social
Engagement

By default, the installation and configuration procedures described above will prepare iWD to support
Genesys Social Engagement. That is, the required database fields will be present in the Interaction
Server and Interaction Server Event Log databases, the required Interaction Custom Properties
(Business Attributes) will be created in Configuration Server, and the required Interaction Server and
Event Log Database Access Point application options will be configured.

Enabling this feature will have the following effect:

¢ A Global Task List custom filter that uses specific social media-related columns will be visible in the
Filters drop-down list.

e Social media-related attributes will be available custom filters in the advanced Filters drop-down list of
the Global Task List.

¢ Social media-related attributes will be visible on the Attributes panel of the Global Task List.

Updating the Tenant to enable display of Social Media Attributes
and Filters
. Log in to the Genesys Administrator Extension.

. Navigate to Configuration Manager > Environment > Tenant.

Select the Tenant to work with.

A W N =

. In the iWD Attributes tab,check the Social Messaging Enabled checkbox and save the change.
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Installing/Removing Language Packs

iWD provides two types of packages related to the localization process:

¢ Those related to the iWD Plug-in for GAX, described here.

e Those related to iWD Manager, Runtime Node and Standard Rules Template (SRT) files, described below.

On Windows

1. Stop iWD Manager web server and Runtime Node services.

2. Launch setup.exe and choose whether to install localization for:

e Manager
* Runtime Node
* Both Manager and Runtime Node
Choose the relevant application(s) from the list.

3. The installer will find the correct path by itself and copy all required files there. A localized SRT will be
installed into iWD Manager in the ruleTemplates directory with a suitable language suffix such as
iWD Standard Rules CHS.

4. Restart the stopped services.

Uninstall also requires that you stop services beforehand.

On Linux

1. Stop iWD Manager web server and the Runtime Node process.

2. Launch ./install.sh and in the dialog that opens, provide:
a.

b.

Type of server—For Tomcat you will be prompted with an additional question about the path.

iWD Manager directory—Provide the path to iWD Manager if you want to install the localization
package to iWD Manager.

iWD Node directory—Provide the path to iWD Runtime Node if you want to install localization
package to iWD Manager.

Destination directory—This is the path where package contents will be extracted.
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3K 3k >k 3k 3k 5k 5K 3K 5k 5k >k 3k Sk 5k >k Sk ok ok 3k 5k 3k >k 3k 3k ok 3k Sk sk >k 3k ok ok 3k 3k sk ok K Sk kK 3k sk kK kok ok k ko

* Welcome to the Genesys 8.5 Installation Script *
3k >k 3k >k ok >k ok sk sk Sk >k Sk sk sk sk sk sk sk Sk sk ok >k sk sk sk Sk sk Sk sk ok sk sk sk sk Sk sk ok >k sk sk sk Sk sk ok kokoskok sk k.

Installing iWD Language Pack, version 8.5.XXX.XX
Please select your servlet container type by number:
1. Tomcat

2. WebSphere

=>1

Please enter the full path to your
Tomcat installation =>SOME_PATH

Please enter iWD Manager directory or press ENTER if iWD Manager is not installed
=>PATH TO MANAGER

Please enter iWD Node directory or press ENTER if iWD Node is not installed
=>PATH TO NODE

Please enter full path of the destination directory for installation =>SOME_WORK PATH
Extracting tarfile: data.tar.gz to directory:
Installation of iWD Language Pack, version 8.5.XXX.XX has completed successfully.

3. Restart the stopped processes.
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Installing/Removing Language Packs

WD Troubleshooting

This section contains the following topics:

e Support for RHEL 64-bit Platforms
* Blocked Lookup Tables
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Support for RHEL 64-bit Platforms

Installers support installation of Red Hat Linux 64-bit platforms only when RHEL standard
compatibility packs for 32-bit platforms have been installed. These packages have generic names
like:

e compat-glibc*

e compat-libstdc++*

e libstdc++* '

You might also need to ensure that the JAVA HOME variable points to the correct JDK.
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Blocked Lookup Tables

When a configuration transaction object already exists with its alias attribute set to
Iwd Lookup Tables List, itis not possible to create a new Lookup Table due to a constraint

violation of the uniqueness of the alias attribute value. An error message is displayed to inform users
about this violation.

If this type of error arises, before checking privileges, do the following:

1. Check whether any object with a different on-screen name and the alias Iwd Lookup Tables List
already exists.

2. If so, back it up then remove and recreate the entire whole Lookup Table from scratch via the GAX
interface.
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Configuration

The folowing topics describe configuration required for iwWD:

* iWD Manager Configuration
* Roles and Privileges Configuration
¢ IWD GAX Plugin Configuration

¢ WD Services Detail
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IWD Manager Configuration
Logging in
Logging in

User Login

Anyone who needs access to iWD Manager must be configured as a Person or in Genesys
Administrator (GA) or Genesys Administrator Extension (GAX)

The login screen prompts for the following information:

¢ Username—The username for the Person or User as configured in GA/GAX.
e Password—The password for the Person or User as configured in GA/GAX.

e CME Application—The name of the iWD Manager Application object as configured in GA/GAX.

Programmatic Login

You can log into iWD Manager programmatically by providing the URL for iwD Manager login page
along with a valid username and password. This can facilitate a single sign-on process.

The URL format to use is:

http://<appserverhost>:<appserverport>/<iwdmanagerapplication>/ui/
login.jsf?username=<username>
&password=<password>=plication=<CMEApplication>&passwordEncoded

Where:
e <appserverhost> and <appserverport> are the host and port for the application server where iWD

Manager is deployed.

e <iwdmanagerapplication> is the iWD Manager application running on the application server (for
example, iwd manager).

e <username> and <password> are a valid username and password combination for the user logging into
iWwD Manager.

<CMEApplication> is the name of the iWD Manager application as configured in the Genesys
Configuration database. You can find the name in GA or GAX. iWD Manager will be shown with an
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application type of iWD Manager.

If you want to include the &passwordEncoded at the end of the URL, then the value for
<password> should be encoded using the BASE64 algorithm. Otherwise, you can pass
a plain-text password in the <password> parameter and omit &passwordEncoded.

An example URL is:

<http://myTomcatHost:8080/iwd manager/ui/
login.jsf?username=jsmith&password=myPassword&CMEApplication=iWDManager

General Conditions for Configuring an iIWD Manager User

General Conditions for Configuring an iIWD Manager User

To access the Global Task List, the Person must be associated with a Place in Genesys
Configuration. If the Person is not an Agent, the Place can be configured as an option on the Annex
tab of the Person/User object. Create a section iWD (if it does not already exist) and within the iWD
section, create an option iWDManagerPlace with the value of a valid Place name.

'If you want a user to have access to a specific managed tenant in iWD, that user must have at least
Read access to the Configuration Server tenant that is linked to that iWD managed tenant—either
directly or by being a member of an Access Group that does. The user must have at least Read &
Execute permissions to the iWD Manager application in Configuration Server, and Read permissions
to the Configuration Server Host object where the Interaction Server is running, either directly or by
being a member of an Access Group that does.

If the user is going to have access to the Global Task List, then the user must have at least
Read and Execute permissions to these application objects in Configuration Server:

e Interaction Server

¢ The Database Access Point for the Interaction Server database

¢ The Database Access Point for the Interaction Server Event Log database.

These permissions may be applied directly to the user, or by the user being a member of an Access
Group that has such permissions.

The Place that must be associated with the user must be a Place configured under the Configuration
Server tenant that maps to the iWD managed tenant. (This presumes that the Interaction Server
application also has an association with this Configuration Server tenant.) The Place is only used to
give the user access to the Global Task List.

If you want to restrict what the user can do in iWD Manager, use roles and privileges as
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described in Role-Based Access Control.

If the user is created under a Configuration Server child tenant, then the following additional
conditions must be met:

* If you want the user to have access to both the iWD SYSTEM tenant as well as the iWD managed tenant
to which the Configuration Server tenant maps, then this user must be either be a member of at least
two Access Groups with the relevant permissions, or must have permissions granted directly to them.

Such Access Groups must have at least Read permission to the tenants.
If the user has no role privilege in a Tenant, then the Tenant is hidden from that user.

If the user is created under the Environment tenant—for example, such as the default user that
is in the Configuration Server database when it is initially deployed, then in order for this user to have
full control of the Global Task List (not just read-only access), two conditions must be met:

e The user must have a valid Place configured, where the Place is created under a child Configuration
Server tenant to which the Interaction Server is associated.

e The user must have an Employee ID that also belongs to a user who is created under a child
Configuration Server tenant to which the Interaction Server is associated.

e The user must have all role privileges from all the "iWD*" groups.

Importing Media Icons

Importing Media Icons

The Media Icons view provides a way to map graphical icons to media types to display in the GTL.
iWD comes with some pre-loaded icons, but additional icons can be uploaded and mapped to existing
media types, or new media types. Icons must be 16x16, but can be in any of the following file
formats:

. GIF
. JPG

.« BMP
. PNG

The following properties and actions are available in the Media Icons panel:

Icon Description

The media type to which the icon will be mapped.
This list of media types is retrieved dynamically
Media Type from Genesys Configuration Server. Media types
are a type of Business Attribute in Configuration
Server. Genesys provides out-of-the-box media
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Icon Description
types but new custom media types can be added.
The graphical 16x16 icon that will be displayed in

Icon the GTL when a task is of the media type to which
the icon is mapped.
File Name The file name of the icon.

Provides a way for you to upload a new icon from

New Icon Mapping the file system.

Opens a File Upload dialog window to enable you

LGEITEE to browse the file system to select an icon.
Upload Uploads the icon selected via the Browse action.
Save/Save and Close/Cancel Standard iWD Manager functions.

Changes in 8.5.0

Only Media Icons are imported/exported into/out of iWD Manager in release 8.5.0.

Prerequisites

¢ iWD Manager, iWD Runtime Node are installed.

* Application servers are started (if running on WebSphere - applications are started).

Procedure

1. Log in to iWD Manager.
2. Open Import/Export in the General section of the System tenant.

3. Import the following files:

e <iWD Manager installation directory>\config\iwd mediaicons.xml.

The XML file is saved to the installation directory where the iWD Manager supporting
files were installed.

* After each import a message appears at the bottom of the screen to indicate whether the import was
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successful.

Filters

Filters

Filters allow you to refine the list of tasks that are displayed in the GTL. Each filter is defined by a set
of filter criteria (optional) and table columns that will be displayed in the GTL.

Preconfigured Filters

The table below lists the attributes and actions that are available in the Filters view.

Filter Attributes

Attribute/Action Description
Name The name of the filter.

Public Whether the filter will be available to all users (checked) or only
the current user (unchecked).

Tasks that do not match the defined criteria will be excluded
from the GTL when the filter is selected. New criteria conditions
can be added by selecting them from the Select criteria to
add drop-down list. Some criteria conditions are parameterized;
A " for such conditions, parameters can be configured directly in a
Filter Criteria criteria table (such as, status for Status is ... criteria).

Custom attributes can be used in many of the filter criteria, with
proper configuration. Custom Attributes for tasks are configured
in the iWD GAX Plugin component. See the Task Attributes tab
of the Data Mart section of iWD GAX Plugin Help.

The GTL will display these columns when the filter is selected.
Columns can be added, removed, and reordered. A user can

Table Columns select from a list that includes all iWD core and extended
attributes, by default. With proper configuration, custom
attributes can also be selected.
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Attribute/Action Description

Save, Save & Close, Cancel, Delete Standard iWD Manager functions.

Creating Custom Filters

Creating a Custom Filter

1. Click Filter > New in the left navigation pane.

2. Check the Public checkbox to make the new filter available to all users. If this box is not checked, only
the current user can view the new filter.

3. From the Select criteria to add drop-down menu at the bottom left, select filter criteria for the new
filter. Use the red delete button displayed to the right of the selected criterion to delete it if required.

4. From the Select column to add drop-down menu at the bottom center, add any new table columns for
displaying the filter output. The current selection of table columns appears to the right of the screen.

Use the up/down arrows to sort the display of the table columns. Use the red delete button to delete
any columns as required.

5. Click Save or Save and Close. The newly created filter is now available for selection in the main Global
Task List window.
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Roles and Privileges in GAX

Role-Based Access Control replaces Security Policies in iWD 8.5. For details of how to use this feature
please see:

* Genesys Administrator documentation set

¢ Genesys Security Guide

* Roles in the main GAX Help (new document).
Role privileges in iWD are arranged in the following groups:

* iWD Solutions

e iWD Departments

e iWD Processes

* iWD Media Icons

e iWD Filters

* iWD Global Task List
¢ iWD Manager Other

Important Information About Filtering Permissions

The following additional information is also important to note when you are filtering permissions:

e Public filters can be changed from Private by any user that has Modify filter permissions.

e The owner of a Private filter can always modify or delete that filter, even if they do not have Delete and/
or Modify security role permissions.

e The username of the owner of a Private filter is displayed on the Filter configuration screen to make
referencing easy..
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Business Structure

Business Structure
[+] DESCRIPTION

The Business Structure is a hierarchy of business units. Each Tenant can contain one or more
Solutions as the first level of the hierarchy. Below Solutions are Departments. Below Departments are

Processes. For example:

e East London Office—Solution (note that this meaning means the top node of a business structure, rather
than the meaning of Solution in Genesys Configuration environment.)

* Finance Department—Department
e Accounts Payable—Process

e Order Processing—Process

Warning

All node names have to be unique within the parent node. For example, moving
department D1 to another solution which already has a department named D1
generates an error.

Warning

Only one business structure per Tenant is possible.

Levels of a Business Structure for a Tenant:

* [+] SOLUTIONS

Solutions are used for partitioning logical and physical resources for purposes of user access control and load partitioning
(performance). Normally there will be one Solution per Tenant, though you can configure multiple solution instances per tenant, if
necessary (for example, “Production” and “Test”).

A Solution in iWD represents a runtime environment, which is composed of the following:

* Runtime nodes—iWD runtime application instances that are within the Java application server in
which services are being run
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* Services—Services that enable iWD functionality, such as Data Mart, Statistics Adapter, and logging.
* Business logic—Primarily the configuration of iWD departments and processes.

The Solution level in a Business Structure corresponds to the Global level in Genesys Rules System for the processing logic of
business rules.

* [+] DEPARTMENTS

A Department represents an administrative unit within a Solution. A Solution can contain many Departments. The Department
level of a Business Structure corresponds to the Department level in Genesys Rules System for the processing logic of business
rules.

* [+] PROCESSES

A Process represents an administrative unit within a Deparatment. A Department can contain many Processes. The Process level
of a Business Structure corresponds to the Process level in Genesys Rules System for the processing logic of business rules.

Display Options

Filters and Constraints

Configuration Server respects tenancy permission settings. You can access only those objects that
you have been granted permissions and privileges to access.

You can filter the contents of this list in two ways:

1. Type the name or partial name of an object in the Quick Filter field.

2. Click the cube icon to open the Tenant Directory filter panel. In this panel, click the Tenant that you
want to select. Use the Quick Filter field in this panel to filter the Tenant list.

You can sort the items in the list by clicking the Name column. Clicking a second time reverses the
sort order. You can add or remove columns by clicking Select Columns.

To select or de-select multiple objects at once, click Select.

Data Fields

Each entry is shown with the following data fields:

* Name—The element's name.

* Type—Solution, Department or Process

e ID—The runtime ID of this element.

¢ Contact Name—Contact name for queries about this element.

¢ Description—Free-format text description of the element.
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Solutions

To create a new Solution

1. Click New.

2. From the displayed list, select the Solution element.

3. Complete the Solution data fields on the form tabs and click Save.

To create a new Solution by cloning

1. Either:
* Select one Solution and click More: or;
» Display the details of an existing Solution.

2. Click Clone.
3. Edit the Solution data fields.

Other Actions

From this context you can Delete this Solution.

Warning

Deleting a Solution can have huge implications for the operation of a contact center.

Do not undertake these without serious consideration.

Solution Details

e Solution Name—The Solution name. Mandatory when you add a new Solution.

e ID—The ID of the Solution. Mandatory when you add a new Solution. The system will propose a default

new Runtime ID.

¢ Timezone—Solution timezone. Use the drop-down list to change this.

e First Day of Week—The first day of the working week for this Solution. Use the drop-down list to

change this.
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Description—Free-format text description of the Solution.

Interaction Server Settings

Interaction Server—The Interaction Server for this Solution. Use the drop-down list to change this.
This drop-down list contains those Interaction Servers which contain the Solution's parent Tenant on
their Tenants list.

Port—The connection port of the Interaction Server. Use the drop-down list to change this. This drop-
down list contains the Interaction Server chosen above ports from the ports list.

If two Solutions are configured to use the same Interaction Server, be aware that the
Port settings (that is, secure or non-secure) of the Solution that is configured second
are the ones that the Interaction Server will use. It is preferable to ensure that both
Solutions' Port settings are of the same type—either both secure, or both non-secure.
Every configuration object or parameter that references the Port ID (and therefore can
be either secure or non-secure) will work in the same way—the setting of the one
configured second (where two Solutions are configured) is the one that the Interaction
Server will use. This affects connection protocol, local timeout, remote timeout, trace
mode and transport protocol parameters.

Connection Protocol—The connection protocol of the Interaction Server. Use the drop-down list to
change this. This parameter is set as the connection attribute of the Interaction Server connection in
the iWD Manager application.

Protocol Timeout—The timeout configured for the connection protocol.

Local Timeout— The timeout configured on the local server. This parameter is set as the connection
attribute of the Interaction Server connection in the iWD Manager application.

Event Buffer Size—The maximum size in bytes of the event buffer.

Remote Timeout—The timeout configured on the remote server. This parameter is set as the
connection attribute of the Interaction Server connection in the iWD Manager application.

Threads—The number of threads available.

EventLog JDBC URL—The URL of the JDBC event log. Mandatory for all database engines set in the
Eventlog DAP (connected to Interaction Server set above), apart from MSSQL.

Attribute Filter Include—Attributes included here will appear in the Custom Attributes displayed in
the Global Task List in iWD Manager.

Attribute Filter Exclude—Attributes excluded here will not appear in the Custom Attributes displayed

in the Global Task List in iWD Manager.

Departments
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To create a new Department

1. Select the Solution or Solution element in which the new Department will be created.
2. Click New.

3. From the displayed list, select the Department element.

4

. Complete the Department data fields on the form tabs and click Save.

To create a new Department by cloning

1. Either:

* Select one Department and click More: or;

* Display the details of an existing Department.
2. Click Clone.
3. Edit the Department data fields.

Other Actions

From here you can Clone, Delete or Move this Department. You can move the Department only to a
Solution. Any Processes configured under it will also be moved. Runtime IDs are not moved in the
Move function—you must create a new one for the Department and all its child Processes in its new
Solution.

Warning

Deleting or Moving a department can have huge implications for the operation of a
contact center. Do not undertake these without serious consideration.

Department Details

 Department Name—The department name. Mandatory when you add a new Department.

ID—The department's Runtime ID. Mandatory when you add a new Department. The system will
propose a default new Runtime ID.

Contact Name—The contact name for the department, for informational purposes.

¢ Contact Email—The contact email for the department, for informational purposes.
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Contact Phone—The contact phone number for the department, for informational purposes.

¢ Start Date—The date on which the department becomes active. If left empty, the period start date is
unconstrained.

 End Date—The last day that the department is active. If left empty, the period end date is
unconstrained (that is, the department will be active infinitely).

e Description—Free-format text description of the Department.

Department Attributes

Click Add to create new attributes.

* Name—The attribute name
¢ Type—Select from the drop-down list. Valid values are:
e Text
* Percentage
* Number
* Date

e Lookup Table

* Value—The attribute value. If the type is a lookup table, then the value is set from the drop-down list.

¢ Description—Free-format text description of the attribute.

Department Metrics

Click Add to create a set of user-defined metrics, for reporting purposes.
[+] MORE

A key component of dashboards and reports is the comparison of actual metrics against target goals.
Understanding the effectiveness or efficiency of organizations requires measuring performance
against important goals that have been set by the organization. Targets can be associated with a
number of objects, such as processes, departments, or tenants. For example, a work-time goal for a
task will differ, based on its process; for example, orders will take longer than address changes. You
can use metrics to measure this. Example:

When a metrics value is set, it will be stored as a named attribute in Data Mart. If the value is
changed, the updates are pushed through to Data Mart with a valid from and valid to date/time
stamp. This is important for historical reporting. For example, if you update the target on November 1
from 2.5 to 3.5, all tasks up to November 1 will use 2.5, and all new tasks will use 3.5. If the value is
set at a department level, it applies to all processes, unless there is a specific value for that process.
For example, Department 1 has four processes: A, B, C, and D. Cost/Task @ Department 1 = 2.50,
which applies to Processes B, C, and D. Cost/Task @ Process A = 1.50, which applies only to Process
A.
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* Name—The metric name
¢ Type—Select from the drop-down list. Valid values are:
* Text
* Percentage
* Number
* Date
* Lookup Table
¢ Value—The attribute value. If the type is a lookup table, then the value is set from the drop-down list.

¢ Description—Free-format text description of the attribute.

Processes

To create a new Process

1. Select the Department or Department element in which the new Process will be created.
2. Click New.

3. From the displayed list, select the Process element.

4

. Complete the Process data fields on the form tabs and click Save.

To create a new Process by cloning

1. Either:

* Select one Process and click More: or;

» Display the details of an existing Process.
2. Click Clone.
3. Edit the Process data fields.

Other Actions

From here you can Clone, Delete or Move this Process. You can move the Process only to a
Department. Runtime IDs are not moved in the Move function—you must create a new one for the
Process in its new Department.

iWD Deployment Guide 88



Configuration IWD GAX Plug-in Configuration

Warning

Deleting or Moving a Process can have huge implications for the operation of a
contact center. Do not undertake these without serious consideration.

Process Detalls

* Process Name—The Process name. Mandatory when you add a new Process.

¢ ID—The Runtime ID of the Process. Mandatory when you add a new Process. The system will propose a
default new Runtime ID.

e Contact Name—The contact name for the process, for informational purposes.
* Contact Email—The contact email for the process, for informational purposes.
e Contact Phone—The contact phone number for the process, for informational purposes.

e Start Date—The date the process becomes active. The start date of the process cannot be earlier than
the start date of the parent department.

 End Date—The last day that the process is active. If left empty, the period end date inherits the end
date value of the parent department.

* Description—Free-format text description of the Process.

Process Attributes

Click Add to create new attributes.

* Name—The attribute name
¢ Type—Select from the drop-down list. Valid values are:
e Text
* Percentage
* Number
* Date

e Lookup Table

¢ Value—The attribute value. If the type is a lookup table, then the value is set from the drop-down list.

¢ Description—Free-format text description of the attribute.
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Process Metrics

Click Add to create new metrics.

[+] MORE

A key component of dashboards and reports is the comparison of actual metrics against target goals.
Understanding the effectiveness or efficiency of organizations requires measuring performance
against important goals that have been set by the organization. Targets can be associated with a
number of objects, such as processes, departments, or tenants. For example, a work-time goal for a
task will differ, based on its process; for example, orders will take longer than address changes. You
can use metrics to measure this. Example:

When a metrics value is set, it will be stored as a named attribute in Data Mart. If the value is
changed, the updates are pushed through to Data Mart with a valid from and valid to date/time
stamp. This is important for historical reporting. For example, if you update the target on November 1
from 2.5 to 3.5, all tasks up to November 1 will use 2.5, and all new tasks will use 3.5. If the value is
set at a department level, it applies to all processes, unless there is a specific value for that process.
For example, Department 1 has four processes: A, B, C, and D. Cost/Task @ Department 1 = 2.50,
which applies to Processes B, C, and D. Cost/Task @ Process A = 1.50, which applies only to Process
A
* Name—The attribute name
* Type—Select from the drop-down list. Valid values are:
e Text
* Percentage
* Number
e Date

* Lookup Table

¢ Value—The attribute value.

* Description—Free-format text description of the attribute.

Data Mart

Data Mart

To apply changes to Datamart settings, you must restart iWD Runtime Node.
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Display Options

Filters and Constraints

Configuration Server respects tenancy permission settings. You can access only those objects that
you have been granted permissions and privileges to access.

You can filter the contents of this list in two ways:

1. Type the name or partial name of an object in the Quick Filter field.

2. Click the cube icon to open the Tenant Directory filter panel. In this panel, click the Tenant that you
want to select. Use the Quick Filter field in this panel to filter the Tenant list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order. You can add or remove columns by clicking Select Columns.

To select or de-select multiple objects at once, click Select.

Data Fields

Each entry is shown with the following data fields:

« Name — Name of the solution hosting iWD Data Mart.

General

Data Fields

¢ Application—The name of iWD Runtime Node application attached to selected Solution. There is a one-
to-one relationship between Solutions requiring Data Mart and iWD Runtime Node applications. The
iWD Runtime Node can be detached from the Solution by entering a blank name in this field.

¢ Host—Host where iWD Runtime Node is installed. Selectable from the list of hosts configured in GAX
Configuration Manager.

¢ Port—Port assigned to iWD Runtime Node. Numeric field, the value must be between 1 and 65535
inclusive. The port must be unique within host.

e ETL Scripts Directory—The directory on the server in which iWD Data Mart ETL scripts are stored. For
example, the default path used when iWD Data Mart is installed is C:\Program Files\GCTI\iWD Data
Mart\etl.

* Number of Threads—Performance tuning: The size of the thread pool.
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* Ignored Dimensions—Performance tuning: list of dimensions that will be ignored by Load Intraday job.
One dimension per line.

e Default Dimension Key—Performance tuning: default value which will be used for ignored
dimensions' keys.

Logging
The Logging tab configures internal logging capabilities within the iWD Runtime Node.
* Log Level — The Service log level. This should be set to Info unless otherwise instructed by Genesys
Technical Support. The possible log levels are:

* Debug — the most detailed informational events that are most useful in debugging an application.
* Info — informational messages that highlight the progress of the application.
* Warning — potentially harmful situations.
» Error — error events that might not affect the application’s ability to run.
e Trace — turns on all logging.
* Off — turns off all logging.

¢ Log Directory — The directory in which the log files will be stored, for all services. If it starts with / (on
Unix-based operating systems) or a drive letter (on Windows), an absolute path will be used; otherwise,
the path is relative from the iWD Runtime Node installation directory.
Note: It is strongly recommended that you only set the file path to a directory on a local machine,
not a remote location such as a shared network drive. Logging to a remote location can severely
impact performance.

* Log Age — Sets the number of days that log files should be kept in the system. A value of 0 disables
this limit.

* Log Size — Sets a limit on the size of a single log file, in megabytes. A value of 0 disables this limit.

¢ Log Files — Sets a limit on the number of log files that are kept for this service, excluding the current
log file. A value of 0 disables this limit.

Database

The Database tab defines a connection to a Data Mart database server. The configured database and

user must exist in the database server. The user must have read/write permissions to the database.
e Application—The name of the Database Access Point application associated with Data Mart instance.
 Database—The name of the database. This is available only for MS SQL Server.

e SID—Oracle System ID of the database. The Oracle System ID (SID) is used to uniquely identify a
particular database on a system. This is available only for Oracle database.

¢ Server—The database server. Selectable from list of configured hosts.

¢ Port—The TCP port number of the database server.
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¢ User Name mdash;The database user name.
¢ Password—The password for the database.

e Auto-Sync—The iWD Data Mart database will be initialized automatically the first time the Database
Service and Kettle ETL Service are started. If the Auto-Sync option is selected, this initialization is
automatic, and the Database Service will also check for updates to the iWD Data Mart database
whenever a new version of iWD Data Mart is installed. The Auto-Sync option will also initialize ETL plug-
ins.

¢ Custom URL—Add a specific custom URL here to override any default value for Data Mart database.

Stat Server

The Stat Server tab configures Statistics Adapter job and defines the connection to Genesys Stat
Server. Statistics Adapter processes the statistical data created by the Aggregate Stats ETL job and
writes stat-types and filters in the configuration for Genesys Stat Server. CCPulse+ requests iWD
statistics from Stat Server, and reads the stat-types and filters from the Stat Server configuration.

Application—The Stat Server's application name. Selectable from the list of installed Stat Server
applications. Each Data Mart requires a separate Stat Server instance, so only Stat Server that are not
already associated appear on the list.

* Dimension Mapping—Defines how statistical dimensions are mapped.
* Filter—Dimensions are mapped to CCPulse+ filters.

* Virtual Queue—Dimensions are mapped to Genesys virtual queues.

¢ Virtual Queue Name—Name of the Genesys virtual queue to which statistics are distributed.
Applicable only if Dimension Mapping is set to Virtual Queue.

¢ Service Index—Statistical service index for configuration options. This should be unique inside the set
of indexes, assigned to statistical services served by the one instance of Genesys Stat Server.

* Extension File Name—Required to support a Genesys reporting environment with multiple instances
of Stat Server Java Extensions. This is the name of the Stat Server Java extension jar file
(BPR _iWD Extension.jar). This file is saved to the Stat Server installation directory during installation
of the iWD Stat Extensions. You can find the location of this file in Stat Server configuration options as
the value of the java-libraries-dir option in the java-config section.

* Extension Section Name—Required to support a Genesys reporting environment with multiple
instances of Stat Server Java Extensions. This property maps to the section name for the specific Stat
Server Java Extension in the Stat Server configuration.

Schedules

The Schedules tab configures execution schedule of three Data Mart job groups. The syntax follow
standard CRON scheduling expression. For example, the following expression will cause the job to be
executed every 15 minutes:

0 0,15,30,45 * * * ?

For more information about CRON scheduling, see Quartz Scheduler documentation.
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¢ Intraday—The schedule for the Intraday job group: Load Config, Load Intraday, Aggregate Intraday,
Aggregate Stats and Statistic Adapter. Typically scheduled to run every 15 minutes.

¢ Historical—The schedule for the Historical job group: Load Historical, Aggregate Historical and
Maintain. Typically scheduled to run once a day, after midnight.

* Prune—The schedule for Prune job. Typically scheduled to run once a day, after Historical group.

Expirations

The Expirations tab configures the Maintain job, which deletes expired facts from Data Mart tables.

¢ Record Details—The number of days after which the detailed task (task fact, task event fact, and
task work fact) data will be removed from the database.

¢ Aggregation 15 min—The number of days after which the data will be removed from 15-minute
aggregation tables.

Tenant Attributes

The Tenant Attributes tab enables selection of up to 5 of a tenant's custom attributes, that will be
loaded into the CUSTOM DIM dimension and associated to the tenant via the CUSTOM DIM KEY field.

¢ Custom Attribute 1-5—User-configured custom Tenant attributes, selectable from the list of Custom
Attributes attached to the Tenant.

Department Attributes

The Department Attributes tab allows selection of up to 5 of a departments's custom attributes
that will be loaded into the CUSTOM DIM dimension and associated to the departments via the
CUSTOM DIM KEY field.

¢ Custom Attribute 1-5—User-configured custom Department attributes, selectable from the list of
Custom Attributes attached to any Department within the Solution.

Process Attributes

The Process Attributes tab allows selection of up to 5 of a process' custom attributes, that will be
loaded into the CUSTOM DIM dimension and associated to the processes via the CUSTOM DIM KEY field.

¢ Custom Attribute 1-5—User-configured custom Process attributes, selectable from the list of Custom
Attributes attached to any Process within the Solution.
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Task Attributes

The Task Attributes tab defines up to 10 names of a task's custom attributes that will be loaded
into the task fact custom attribute fields (CUSTOM ATTRIBUTE 1-10). Names must start with a
letter, and only underscores and alphanumeric characters are supported.

In order for Kettle to pick them up, it is necessary to create fields in the Event Log Database. In the
rpt _interaction and rpt esp tables, add the fields in the following format:

*: Name: <attribute name>, type: varchar(length).

These fields should be added to the mappings in the Event Log DAP options in the esp-custom-data
and itx-custom-data sections.

For example, in order to store a custom attribute with the name order total in the iWD Data Mart,
as a task custom attribute:

1. Create a new column in the rpt_interaction table: order total, type: varchar(50)

2. Create a new column in the rpt_esp table: order total, type: varchar(50)

3. Create a new option in the esp-custom-data section of the Event Log DAP options:
order total=order total

4. Create a new entry option in the itx-custom-data section of the Event Log DAP options:
order total=order total

5. Add order_ total to the Task Attributes list in iWD GAX Plugin.

Dimension Mapping

The Dimension Mapping tab defines up to 5 comma-separated names of a task's custom attributes
that will be loaded into the CUSTOM DIM dimension and associated to the task via the
CUSTOM DIM KEY field. Names must start with a letter, and only underscores and alphanumeric
characters are supported.

In order for Kettle to pick them up, it is necessary to create fields in the Event Log Database. In the
rpt_interaction and rpt_esp tables, add the fields in the following format:

*: Name: <attribute name>, type: varchar(length).

These fields should be added to the mappings in the Event Log DAP options in the esp-custom-data
and itx-custom-data sections.

For example, in order to store a custom attribute with the name order_total in the iWD Data Mart,
as a task custom attribute:

1. Create a new column in the rpt_interaction table: order total, type: varchar(50)

2. Create a new column in the rpt_esp table: order total, type: varchar(50)

3. Create a new option in the esp-custom-data section of the Event Log DAP options:
order total=order total
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4. Create a new entry option in the itx-custom-data section of the Event Log DAP options:
order total=order_ total

5. Add order_total to Dimension Mapping list in iWD GAX Plugin.

Lookup Tables

Lookup Tables

Lookup Tables
[+] MORE

You can specify lookup tables that can be used in rules, custom attributes, and metrics. Lookup tables
are simple key/label pairs and are displayed as dropdown controls. Although business rules are
managed in the Genesys Rules System, it is still possible to create rule parameters that use values
from iWD Lookup Tables. Example: the taskChannels parameter in the iWD Standard Rules Template
presents the user with a list of task channels that are read from an iWD Lookup Table.

The taskChannels parameter is configured as a database type rule parameter. The configuration of
that parameter instructs the Genesys Rules Authoring Tool how to query the iWD configuration
database to retrieve the values of the out-of-the-box iWD Lookup Table called channels. To create
additional rule parameters that will retrieve the values from other Lookup Tables, you can make
copies of the taskChannels parameter and modify the SQL query, changing the name of the Lookup
Table from channels to the name of your Lookup Table.

Display Options

Filters and Constraints

Configuration Server respects tenancy permission settings. You can access only those objects that
you have been granted permissions and privileges to access.

You can filter the contents of this list in two ways:

1. Type the name or partial name of an object in the Quick Filter field.

2. Click the cube icon to open the Tenant Directory filter panel. In this panel, click the Tenant that you
want to select. Use the Quick Filter field in this panel to filter the Tenant list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
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reverses the sort order. You can add or remove columns by clicking Select Columns.

To select or de-select multiple objects at once, click Select.

Data Fields

Each entry is shown with the following data fields:

¢ Name—The element's name.

Actions

To add a new Lookup Table

Either:

* From the List view, click New and complete the Lookup Table's details.

e Display the details of a Lookup Table and click Clone, then edit the details.

To add a new key/label pair to a Lookup Table

Display the Lookup Table by selecting it, then click Add and complete the new details.

Other Actions

From this context you can Delete or Move this Lookup Table. You can move the Lookup Table only to
another Tenant. Runtime IDs are not moved in the Move function—you must create a new one for
theLookup Table in its new Tenant.

Warning

Deleting or Moving a Lookup Table can have huge implications for the operation of a
contact center. Do not undertake these without serious consideration.
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Distribution Points and Lookup Tables

Distribution Points are attributes that can be assigned to tasks in business rules, and there is still a
Distribution Point dimension for this purpose in the iWD Data Mart schema.

Distribution Points must be configured as Lookup Tables at the Tenant level. The following procedure
describes the steps that are used to configure Distribution Points as Lookup Tables.

Configuring Distribution Points as Lookup Tables

1. In iWD GAX Plugin, configure a new Lookup Table for your tenant. The name of the Lookup Table must be
distributionPoints.

2. The distributionPoints lookup table must be configured under the iWD managed tenant in which the
rule action to assign the distribution point to a task is defined.

3. Start using the rule action Assign distribution point in your business rules.
There is a rule action in the iWD Standard Rule Template called Assign distribution point

that uses a rule parameter configured to read the values from the distributionPoints Lookup
Table. This rule action can be used in a business rule.
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IWD Services

Services are configured per solution, and each solution must be configured under a
tenant in GAX. Therefore, before configuring services, you must configure a Tenant
and Solution.

Most iWD Services are now configured in the GAX environment using the iWD Plug-in for GAX. Please
refer to these documents for details of configuring iWD services.

* iWD GAX Plug-in Help
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WD Reporting

Reporting Services

The Statistics Adapter Service allows performance of custom aggregations on data and sends the
resulting statistics to Genesys Stat Server. Statistics then can be viewed in CCPulse+ or any other
Stat Server client.

Historical reporting is enabled by a number of ETL jobs that transform and load iWD runtime data into
a separate reporting database that is called the iWD Data Mart for a list of preconfigured ETL jobs).
Essentially, the iWD Data Mart is a set of star schemas that contain historical iWD data that is
optimized for reporting. The ETL jobs are set up as scheduled services in iWD. Refer to the iWD 8.5
Data Mart Reference Guide for more information.

Configuring CCPulse+ for iwD

Purpose

In Genesys, iWD current-day statistic measure types are presented as statistic objects, and iWD
statistic dimensions are defined as filters. Therefore, it is necessary to combine statistic objects with
filters in order to get a measure type for a dimension.

Prerequisites
¢ The iWD Data Mart database has been created, and the corresponding Database service has been
configured and is running.
* The Aggregate Statistics ETL job is configured and running.
e Stat Server must be running, with the iWD Stat Extensions installed.

¢ The Statistics Adapter service must be configured and running.

1. Start CCPulse+, and connect to the Genesys Stat Server (File > New).

2. In the Object Types dialog box, select the Virtual Queue object type for the corresponding Genesys
tenant and switch, and click Next.

3. In the Object Instances dialog box, select the virtual queue that is used by the iWD to submit
statistics, and click Finish.

This is the virtual queue that was specified in setup using the iWD Setup Utility.
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Next Steps

To be able to view iWD current-day statistics in Genesys CCPulse+, it is necessary to create a
CCPulse+ template. The following procedure explains how to create a CCPulse+ template.

Creating a CCPulse+ template

Purpose

To create a CCPulse+ template to use to view iWD current-day statistics.

1. Open the CCPulse+ template wizard by selecting Template Wizard... from the Tools menu.

2. In the Template Definition dialog box, select the Virtual Queue object type in the Available Object
Types list, then select the Create New Template option, and click Next.

3. In the Pre-defined Statistics dialog box, enter the template name, then click the New Group button,
and enter a name for the newly created statistic group.

4. Expand the TotalCustomValue stat type in Available Statistics tree view, and select the iWD statistic
that you want to add to the template (all iWD statistic names have a “GTL’ prefix).

5. Click the >> button to add the selected statistic to the newly created statistic group.

6. In the Requested Statistics tree view, select the newly added statistic, and then click the Properties
button.

7. In the Statistic Properties dialog box enter Alias (which is how the statistic is displayed in
CCPulse+). Set Insensitivity Value to 1; set Interval Type to Selection and GTLAggregated; set
Notification Node to Changes Based; and set Filter to the filter type that represents the required
iWD dimension; and then click OK..

8. Add more statistics and statistic groups, if necessary, and then click the Next button.

9. In the Graph dialog box, adjust graph parameters, if necessary, and then click Finish.

10. In the CCPulse+ main window, select the virtual queue instance that is used by the iWD to submit
statistics. Create a real-time view for this virtual queue:
In the Real-Time Data Template dialog box, select the previously created template from the
list, and click OK.

End
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Customer and Partner Translation

Extracting localization files from IWD Manager

Prerequsities

¢ iWD Manager installed in base (en-US) localization - without Genesys-provided localization package

Procedure

1. Locate the Tomcat directory, where iWD Manager is installed.

2. Within the Tomcat directory, locate file webapps/iwd manager/WEB-INF/lib/iwd common.jar.

3. Extract file evo/resources/resources.properties from the iwd common. jar file to a temporary
location. File iwd common. jar is a zip file and can be opened with 7zip or WinZip utility on Windows
and unzip utility on Linux.

4. In the Tomcat directory, locate file webapps/iwd manager/WEB-INF/classes/evo/cmc/ui/resources/

resources.properties. Append the content of this file to the extracted resources.properties file
saved in the temporary location.

Extracting localization files from IWD Datamart Node

Prerequisities

¢ WD Datamart Node installed in base (en-US) localization - without Genesys-provided localization

package
Procedure

1. Locate file lib/iwd common. jar within the iWD Datamart Node installation directory.

2. Extract file evo/resources/resources.properties from the iwd_common. jar file to a temporary
location. File iwd common. jar is a zip file and can be opened with 7zip or WinZip utility on Windows
and unzip utility on Linux.

3. Locate file lib/iwd dm. jar within the iWD Datamart Node installation directory

4. Extract file evo/gtl/datamart/resources/resources.properties from the iwd dm.jar to a
temporary location. File iwd_dm. jar is a zip file and can be opened with 7zip or WinZip utility on
Windows and unzip utility on Linux.

5. Concatenate both extracted files.
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Extracting localization files from IWD GAX Plugin

Prerequisities

* Genesys Administration Extension package installed

¢ iWD GAX Plugin installed within Genesys Administration Extension

Procedure

1. Locate file iwd gax. jar within the Genesys Administration Extension installation directory.

2. Extract file web/nls/1k.js from iwd gax.jar to a temporary location. File iwd gax.jar is a zip file and
can be opened with 7zip or WinZip utility on Windows and unzip utility on Linux.

Translating the resources.properties localization file

Prerequisities

e File resources.properties extracted from appropriate iWD package and saved in temporary location
e JDK 7 installed

Procedure

1. Rename file resources.properties to resources.utf8.

2. Translate the file resources.utf8. Each line in the file contains a key and value separated by the ‘=’
character. Only the value part needs to be translated—key and ‘=" character must remain unchanged.
Any text in braces {} must remain unchanged. The file should be saved in UTF-8 encoding.

3. Use the native2ascii utility located in JDK 7 to convert file resources.utf8 into resources.properties
native2ascii —encoding utf8 resources.utf8 resources.properties.

Translating the Ik.js localization file
Prerequisities

¢ Localization file extracted from iWD Plug-in for GAX and saved in temporary location
Procedure

1. Only text in quotes needs to be translated. Any text in braces {} is a parameter and must be left
unchanged.

2. The file must be saved in UTF-8 encoding.
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Installing translated resources.properties in IWD Manager

Prerequisities

* iWD Manager package is installed in base (en-US) localization - without Genesys-provided localization
package

¢ Translated resources.properties file is available in temporary location
Procedure

1. Locate the Tomcat directory, where iWD Manager is installed

2. Copy file resources.properties into webapps/iwd manager/WEB-INF/classes directory within
Tomcat.

3. Restart Tomcat.

Installing the translated resources.properties in IWD Datamart
Node

Prerequisities

e iWD Datamart Node installed in base (en-US) localization - without Genesys-provided localization
package

» Translated resources.properties file is available in temporary location
Procedure

1. Copy file resources.properties to the config directory within iWD Datamart Node installation
directory

2. Restart iWD Datamart Node.

Installing the translated Ik js in IWD Plug-in for GAX

Prerequisities

¢ Genesys Administration Extension package installed

* Appropriate localization package for Genesys Administration Extension installed (either Genesys- or
Customer-provided)

¢ iWD GAX Plugin installed within Genesys Administration Extension

Translated lIk.js file is available in a temporary location

Procedure
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1. Locate file iwd gax.jar within the Genesys Administration Extension installation directory

2. Update file web/nls/1k.js in iwd gax.jar in the temporary location. File iwd_gax.jar is a zip file and
can be updated with 7zip or WinZip utility on Windows and zip utility on Linux.

3. Restart Genesys Administration Extension.
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High Availability

High Availability for IWD Components

The Interaction Server Integrated Capture Points support warm standby. For more information about
this support, see the eServices Multi-tenancy and Load Balancing Guide.

The iWD Manager and iWD Runtime Node components support only single node deployments.

Configuring a GRE Cluster

Please refer to the Genesys Rules System Deployment Guide for information about how to
configure a cluster of rules engines to provide a load-balanced solution.
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